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前言
简介

本章包含使用 PICkit™ 3 在线调试器 / 编程器前需要了解的一般信息。内容包括：

• 文档编排

• 本指南使用的约定

• 推荐读物

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXA_CN”，其中 “XXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
 2013 Microchip Technology Inc. DS52116A_CN 第 7 页
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文档编排

本文档介绍了如何使用 PICkit 3 作为开发工具在目标板上仿真和调试固件，以及如何
烧写器件。文档内容编排如下：

第 1 部分——入门

• 第 1 章 关于在线调试器 / 编程器
介绍了 PICkit 3 以及其如何帮助开发应用。

• 第 2 章 工作原理
讲述了 PICkit 3 的工作原理。介绍了配置选项。

• 第 3 章 调试器使用
介绍了安装和设置、常用调试功能、使用目标板、设置 MPLAB® 集成开发环境
（Integrated Development Environment， IDE）以及调试器相关主题。

• 第 4 章 PICkit 3 Debug Express
提供关于如何使用 PICkit 3 Debug Express 的基本信息。

• 第 5 章 PICkit 3 脱机编程
提供了有关在 PICkit 3 设备未连接到个人计算机 （Personal Computer， PC）的
情况下，如何使用 PICkit 3 烧写器件的指示信息。

第 2 部分——故障诊断

• 第 6 章 故障诊断首要步骤 ——调试器运行出现问题时首先应该尝试的操作。

• 第 7 章 常见问题解答 （FAQ）——常见问题列表，有利于故障诊断。

• 第 8 章 错误消息 ——错误消息和建议解决方案的列表。

• 第 9 章 工程技术说明 （ETN）

第 3 部分——参考信息

• 附录 A 硬件规范——调试器系统的硬件和电气规范。

• 附录 B PICkit 3 原理图

• 附录 C 版本历史
DS52116A_CN 第 8 页  2013 Microchip Technology Inc.
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本指南使用的约定

本指南采用以下文档约定：

文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide
需强调的文字 ……为仅有的编译器……

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 Enable Programmer
引用 窗口或对话框中的字段名 “Save project before build”
带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK
选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数字，其中 N
为总位数， R 为基数， n 为其
中一位。

4‘b0010， 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按下 <Enter>， <F1>
Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm， _endasm， static

命令行选项 -Opa+，-Opa-

二进制位值 0， 1

常量 0xFF， ‘A’

斜体 Courier New 可变参数 file.o， 其中file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [options] file 
[options]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

 2013 Microchip Technology Inc. DS52116A_CN 第 9 页
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推荐读物

本用户指南介绍了如何使用 PICkit 3。下面列出了其他有用的文档。以下 Microchip 文
档均已提供，并建议读者作为补充参考材料。

Multi-Tool Design Advisory （DS51764）

请先阅读本文档！其中包含有关在使用 PICkit 进行目标设计时应考虑的操作问题的重
要信息。

PICkit 3 的版本说明

有关使用 PICkit 3 的最新信息，请阅读 Start （开始）页上 “Release Notes and 
Support Documentation”（版本说明和支持文档）下的版本说明。版本说明包含了本
用户指南中可能未提供的更新信息和已知问题。

《MPLAB® X——使用 PICkit™ 3 在线调试器》海报 （DS52010A_CN）

本海报说明了如何使用标准通信和目标板为 PICkit 3 编程器 / 调试器连接硬件和安装软
件。

PICkit 3 在线调试器 / 编程器在线帮助文件

MPLAB X IDE 随附了全面的调试器帮助文件。内容涵盖了调试器的使用、故障诊断和
硬件规范。此文件可能比本印刷文档更新。而且，还列出了针对各种器件的限制。

Processor Extension Pak and Header Specification （DS51292）
本小册子介绍了如何安装并使用调试头来更好地调试所选器件，而无需占用额外的引
脚和资源。另请参见 PEP 和调试头在线帮助文件。

Transition Socket Specification （DS51194）
可参考本文档获取有关适用于调试头的转换插座的信息。
DS52116A_CN 第 10 页  2013 Microchip Technology Inc.
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第 1 章  关于在线调试器 / 编程器
1.1 简介

提供了 PICkit™ 3 在线调试器 / 编程器系统的概述。

• PICkit 3 在线调试器 / 编程器定义

• PICkit 3 在线调试器 / 编程器提供的功能

• PICkit 3 在线调试器 / 编程器组件

1.2 PICkit 3 在线调试器 / 编程器定义

PICkit 3 在线调试器 / 编程器 （见图 1-1）是一款简单、低成本在线调试器，通过 PC
在 Windows® 平台上运行 MPLAB X IDE 软件控制。 PICkit 3 在线调试器 / 编程器是开
发工程师工具套件中不可缺少的部分。可用于从软件开发到硬件集成等各种应用领域。

PICkit 3 是用于为基于在线串行编程 （In-Circuit Serial Programming™， ICSP™）和
增强型在线串行编程 2 线串行接口的 Microchip PIC® 单片机 （MCU）和 dsPIC® 数字
信号控制器 （Digital Signal Controller， DSC）进行软硬件开发的调试器系统。

除了调试器功能， PICkit 3 在线调试器 / 编程器系统也可用作开发编程器。

PICkit 3 调试器是为编程和调试带调试功能的嵌入式处理器开发的。 PICkit 3 功能包
括：

• 使用 Windows 标准驱动程序的全速 USB 支持

• 实时执行

• 处理器以最大速度运行

• 内置过压 / 短路监视器

• 低至 5V 的低电压 （范围为 1.8-5V）
• 诊断 LED （电源、活动和状态）

• 读 / 写单片机的程序和数据存储器

• 擦除所有存储器类型 （EEPROM、 ID、配置和程序）并带有校验功能

• 断点处冻结外设

注： PICkit 3 在线调试器 / 编程器不是生产编程器。应仅用作开发目的。
 2013 Microchip Technology Inc. DS52116A_CN 第13 页
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图 1-1： PICkit™ 3 MCU 在线调试器 / 编程器

1.2.1 挂绳环

挂绳环提供了连接点以便挂起或佩戴 PICkit 3。

1.2.2 USB 端口连接

此 USB 端口连接为 USB 微型 B 连接器。请使用附带的 USB 电缆将 PICkit 3 连接到
PC。

1.2.3 引脚 1 标记

此标记指示引脚 1 的位置以确保连接器正确对齐。

6

21

3

4

图示：

1 - 挂绳环

2 - USB 端口连接

3 - 引脚 1 标记

4 - 编程连接器

5 - 指示 LED
6 - 按钮

5
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关于在线调试器 / 编程器
1.2.4 编程连接器

编程连接器是一个 6 引脚连接头 （0.100" 间距），用于连接到目标器件。引脚排列规
范，请参见图 1-2。

图 1-2： PICkit™ 3 编程器连接器引脚排列

1.2.5 指示 LED
指示 LED 指示 PICkit 3 的工作状态。

1. Power （电源）（绿色）——PICkit 3 已通过 USB 端口上电

2. Active （活动）（蓝色）——连接到 PC USB 端口，并且通信链路是活动的

3. Status （状态）（三种颜色之一）

成功 （绿色）——准备启动或成功完成

忙 （橙色）——正忙于处理某项功能，例如编程

错误 （红色）——发生错误

1.2.6 按钮

按钮用于脱机编程（Programmer-To-Go）操作。请参见第 5 章“PICkit 3 脱机编程”。

1
2
3
4
5
6

*  此 6 引脚连接头 （0.100" 间距）可连接 0.025" 的方形引脚。

引脚说明 *
1 = MCLR/VPP

2 = 目标器件的 VDD

3 = VSS （地）

4 = PGD （ICSPDAT）
5 = PGC （ICSPCLK）
6 = PGM （LVP）

引脚 1 指示

注： 编程串行 EEPROM 器件时编程连接器引脚排列有些不同。这些类型器件
的引脚排列，请参见随 MPLAB X IDE 软件一起提供的 PICkit 3 自述文件
（MPLAB X IDE 的 Start 页上，单击 Release Notes and Support 
Documentation）。

注： 闪烁 LED 指示更多信息。详情请参见表 5-2。
 2013 Microchip Technology Inc. DS52116A_CN 第 15 页
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1.3 PICkit 3 在线调试器 / 编程器提供的功能

PICkit 3 在线调试器 / 编程器使您能：

• 在自己的硬件上实时调试您的应用程序

• 调试硬件断点

• 基于内部事件设置断点

• 监视内部文件寄存器

• 全速仿真

• 编程器件

1.4 PICkit 3 在线调试器 / 编程器组件

PICkit 3 在线调试器 / 编程器系统包含以下组件：

1. 带电源、活动和状态指示灯的 PICkit 3。
2. 提供调试器和 PC 之间的通信并为调试器供电的 USB 电缆。

图 1-3： 基本调试器系统

可单独订购的其他项：

• PICkit 3 Debug Express 工具包，包含：

- 带 PIC18F45K20 MCU 的 44 引脚演示板

- 用于 PIC18 MCU 的免费版 MPLAB C 编译器

- 浅显易懂的课程和教程

- 其他软件实用程序、源代码示例和完整文档

• 转换插座

• ICD 调试头

• MPLAB X IDE 处理器扩展工具包

PICkit 3

到目标板

 连接到 PC

指示灯

 的 USB 电缆
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第 2 章  工作原理
2.1 简介

本章简要概述了 PICkit 3 在线调试器 / 编程器系统的工作原理。旨在提供足够的信息，
来帮助用户设计与调试器兼容的目标板，以进行调试和编程操作。描述了在线调试和
编程的基本原理，以便用户能够快速地解决遇到的问题。

• 工具比较

• PICkit 3 与 PICkit 2 的对比

• 调试器与目标板之间的通信

• 通信连接

• 调试

• 调试要求

• 编程

• 调试器使用的资源
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2.2 工具比较

PICkit 3 在线调试器 / 编程器系统与 Microchip 的其他调试工具在物理和操作方面有所
不同，如下表所示。特殊功能因器件不同而异 （请参见在线帮助文件 “Device and 
Feature Support”（器件和功能支持）。）

2.3 PICkit 3 与 PICkit 2 的对比

PICkit 3 在线调试器 / 编程器系统在功能上与 PICkit 2 在线调试器系统类似。

这两个调试器相似点包括：

• 通过 USB 电缆连接到 PC 供电

• 提供可编程的电压源

PICkit 3 与 PICkit 2 的不同之处在于具有下列附加功能：

• 扩展的 EE 程序映像空间 （512 KB）
• 真正的参考电压

• 扩大的电压范围 （1.8-5V VDD ； 1.8-14V VPP）

表 2-1： 调试工具比较

功能
PICkit 3

编程器 / 调试器

MPLAB ICD 3
在线调试器

MPLAB REAL ICE
在线仿真器

USB 速度 仅全速 高速和全速 高速和全速

USB 驱动程序 HID Microchip Microchip

USB 供电 有 有 有

为目标供电 有 有 无

可编程 VPP 和 VDD 有 有 有

从目标板灌入 VDD 的电流 20 mA <1 mA <1 mA

过压 / 过流保护 有（软件） 有（硬件） 有 （硬件）

器件仿真 全速 全速 全速

硬件断点 简单 复杂 复杂

跑表 有 有 有

软件断点 无 有 有

程序映像 512 KB 无 无

序列化 USB 有 有 有

跟踪 无 无 有

数据捕捉 无 无 有

逻辑探针触发器 无 无 有

高速 /LVDS 连接 无 无 有

生产编程器 无 有 有
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2.4 调试器与目标板之间的通信

以下小节介绍了调试器系统配置。

标准 ICSP 器件通信

可将调试器系统配置为使用标准 ICSP 通信执行编程和调试功能。此 6 引脚连接方式
与以前的 PICkit 2 开发编程器 / 调试器使用的连接方式相同。

模块化电缆可被插入到：

• 目标板上与之匹配的插座中，其中目标器件在目标板上 （图 2-1），或

• 标准适配器 / 调试头板组合 （作为处理器套件提供）中，然后插入目标板 （图
2-2）。

关于标准通信的更多信息，请参见附录 A “硬件规范”。

图 2-1： 标准调试器系统——内置 ICE 电路的器件

警告

建立任何硬件连接前先安装软件，即不要在安装软件和 USB 驱动程序之前连接硬件。

不要在 PICkit 3 和 / 或目标板上电时更改硬件连接。

注： 以前的调试头板使用 6 引脚模块化连接器，而不是 6 引脚单列直插式连接
器，因此这些调试头可通过 AC164110 ICSP 适配器连接到调试器。

目标器件

或 PIM

电源

PICkit 3

连接到 PC 的
微型 USB 电缆

目标板
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图 2-2： 标准调试器系统——ICE 器件

目标板转换插座

器件 - ICE

AC164110
适配器

调试头

电源

PICkit 3

连接到 PC 的
微型 USB 电缆
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2.5 通信连接

2.5.1 标准通信目标板连接

2.5.1.1 使用单列直插式连接器

在 PICkit 3 在线调试器 / 编程器和目标板连接器之间使用 6 引脚直插式连接器。请参见
图 2-1。另请参见表 2-2 和第 A.6 节 “标准通信硬件”。

2.5.1.2 使用适配器

PICkit 3 在线调试器 / 编程器使用 AC164110 适配器通过模块化接口 （6 芯）电缆连接
到目标器件。连接器的引脚编号显示在目标 PCB 的底部，如图 2-3 所示。

图 2-3： 目标板上的标准 RJ-11 连接

表 2-2： 目标板连接器引脚排列

连接器引脚 单片机引脚

1 MCLR/VPP

2 VDD

3 地

4 PGD （ICSPDAT）
5 PGC （ICSPCLK）
6 PGM （LVP）

注： 调试器和目标板上的电缆连接互为镜像，即电缆一端上的引脚 1 连接到电
缆另一端的引脚 6。请参见第 A.6.2.3 节 “模块化电缆规范”。

1

2

3

4

5

6

目标
连接器

目标

底部
PCBVPP/MCLR

Vss

PGC
VDD

PGD
LVP
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2.5.2 目标板连接电路

图 2-4 显示了 PICkit 3 在线调试器 / 编程器与目标板上连接器的互连情况。该图还显示
了从连接器到目标 PCB 上器件的连线。建议在 VPP/MCLR 线和 VDD 之间接一个上拉
电阻 （通常约为 10 kΩ 左右），这样可将 VPP/MCLR 线置为低电平来复位器件。

图 2-4： 目标电路的标准连接

2.5.3 目标供电

在下面的说明中，将只谈到与关键调试器操作相关而且有效的三根线：引脚 1
（VPP/MCLR）、引脚 5 （PGC）和引脚 4 （PGD）。图 2-4 中显示了引脚 2 （VDD）
和引脚 3 （VSS）是出于完整性考虑。 PICkit 3 为给目标器件供电提供了两种配置：内
部调试器和外部目标电源。

推荐使用来源于目标应用的外部电源。在此配置中，目标 VDD 由调试器检测，以允许
进行电平转换使之适用于目标低电压操作。如果调试器在其 VDD 线 （接口连接器的引
脚 2）上检测不到电压，它将不能工作。

2.5.4 调试器供电

内部调试器电源电流限制为 30 mA。这对于那些为独立编程而将器件 VDD 与应用电路
的其余部分隔离开的小型应用很有用，但是不推荐普遍使用，因为它对源自 PC 的
USB 供电系统有更高的电流要求。

不是所有的器件都有 AVDD 和 AVSS 线，但是如果目标器件上有这两根线，为了调试器
能够正常工作，必须将它们连接到合适的电平。它们不能处于悬空状态。

同时，带 VCAP 线的器件 （例如 PIC18FXXJ MCU）应该连接到合适的电容或电平。

VDD

VPP/MCLR
PGC
PGD
VSSAVDD

AVSS

2

1
5
4
3

4.7K-10K

接口
连接器

应用
PCB

器件

注： 相互连接非常简单。发生的所有问题通常是由这几根关键线上的其他连接
或元器件影响 PICkit 3 在线调试器 / 编程器的运行引起的。
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2.5.5 影响调试器正常运行的电路

图 2-5 中显示了在调试器的有效线上连接某些元器件会影响 PICkit 3 调试器系统正常
运行。

图 2-5： 不正确的电路元器件

确切地说，必须遵循以下准则：

• PGC/PGD 不要接上拉——上拉会破坏电压值，因为这些线在调试器中有 4.7 kΩ
的下拉电阻。

• PGC/PGD 不要接电容——在编程和调试通信期间，它们会阻止数据线和时钟线上
电平的快速转换。

• MCLR 不要接电容——它们会阻止 VPP 上电平的快速转换。通常一个简单的上拉
电阻就已足够。

• PGC/PGD 不要接二极管——它们会阻止调试器和目标器件间的双向通信。

不允许！

不允许！

不允许！
允许！

VPP/MCLR

PGC

PGD

1

5

4

接口
连接器

不
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2.6 调试

使用 PICkit 3 在线调试器 / 编程器系统作为调试器有两个步骤。第一步需要将应用程序
烧写到目标器件 （通常使用 PICkit 3 自身）。第二步使用目标闪存器件的内部在线调
试硬件来运行和测试应用程序。这两步与 MPLAB X IDE 操作直接相关：

1. 将代码烧写到目标器件并激活具体的调试功能 （详细信息请参见下一节）。

2. 使用调试器设置断点并运行。

如果目标器件不能被正确编程，那么 PICkit 3 在线调试器 / 编程器将无法进行调试。

图 2-6 显示了编程所要求的基本电路互连。注意这与图 2-4 相同，为清楚起见，不显
示调试器的 VDD 和 VSS 线。

图 2-6： 编程要求的正确连接

上图显示了 PICkit 3 在线调试器 / 编程器的一些内部接口电路的简化框图。编程时，目
标器件不需要时钟，但必须为其提供电源。编程时，调试器在 VPP/MCLR 上施加编程
电压，通过 PGC 发送时钟脉冲并通过 PGD 发送串行数据。要校验器件是否已被正确
编程，可以向 PGC 发送时钟，并通过 PGD 读回数据，这符合开发阶段所使用器件的
ICSP 协议。

+5V

编程

4.7 kΩ

4.7 kΩ

VPP/MCLR

PGC

PGD

1

5

4

内部电路

VSS

VDD
电压
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2.7 调试要求

要使用 PICkit 3 在线调试器 / 编程器系统进行调试 （设置断点和查看寄存器等），以下
几个关键因素必须正确：

• 调试器必须连接到 PC。必须由 PC 通过 USB 电缆对其供电，并且必须通过 USB
电缆与 MPLAB X IDE 软件通信。更多详细信息，请参见第 3 章 “调试器使用”。

• 调试器必须如图 2-6 所示，通过模块化接口电缆 （或同等规格的电缆）连接到目
标器件的 VPP、 PGC 和 PGD 引脚。调试器和目标器件之间的 VSS 和 VDD 也需要
连接起来。

• 目标器件必须有电源和正常运行的振荡器。无论是什么原因使目标器件不工作，
PICkit 3 在线调试器 / 编程器都不能进行调试。

• 必须对目标器件的配置字进行正确编程：

- 振荡器配置位应与 RC 和 XT 等相对应，具体取决于目标板的设计。

- 某些器件的看门狗定时器默认情况下是使能的，需要禁止。

- 不要使能目标器件的代码保护功能。

- 不要使能目标器件的表读保护功能。

• 应禁止 PGM （LVP）。

满足了以上条件后，即可接着进行下列操作：

• 进入调试模式的操作序列

• 调试详细信息

2.7.1 进入调试模式的操作序列

如果满足了调试要求，那么在从 MPLAB IDE 菜单把 PICkit 3 在线调试器 / 编程器设置
为当前工具（Edit>Project Properties，Advanced，MPLAB Environment（编辑 > 项
目属性，高级， MPLAB 环境）时，可以执行这些操作：

• 当选择了 Debug>Debug Project （调试 > 调试项目）时，应用程序代码就会通过
本章开始描述的 ICSP 协议烧写到器件存储器。

• 一个小的 “调试执行程序”被载入到目标器件的程序存储器的高地址段。由于调
试执行程序必须驻留在程序存储器中，因此应用程序不能使用此保留的空间。有些
器件为调试执行程序提供了专门的存储区。详细信息请参见器件数据手册。

• MPLAB X IDE 使能目标器件中的特殊 “在线调试”寄存器。这使得调试执行程序
能被调试器激活。关于器件保留资源的更多信息，请参见第 2.9 节 “调试器使用
的资源”。

• 目标器件在调试模式下运行。
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2.7.2 调试详细信息

图 2-7 显示了准备好调试的 PICkit 3 在线调试器 / 编程器系统。

图 2-7： 准备好调试的 PICkit™ 3 调试器

一般情况下，为判断应用程序能否正确运行，可在程序代码中预先设置断点。当通过
MPLAB X IDE 的用户界面设置断点时，断点的地址保存在目标器件的特殊内部调试寄
存器中。 PGC 和 PGD 上的命令直接传送到这些寄存器来设置断点地址。

下一步，在 MPLAB X IDE 中选择 Debug>Debug Project 功能。然后，调试器通知调
试执行程序运行。目标器件从复位向量开始执行，直到程序计数器到达先前存储在内
部调试寄存器中的断点地址为止。

执行了断点地址处的指令之后，目标器件的在线调试机制就会启动，并将器件的程序
计数器值传递给调试执行程序 （很像中断），用户的应用程序暂停执行。调试器通过
PGC 和 PGD 与调试执行程序通信，获取断点状态信息，并将这些信息传送回 MPLAB 
X IDE。 MPLAB X IDE 接着向调试器发送一系列查询以获取关于目标器件的信息，例
如文件寄存器内容和 CPU 状态。这些查询最终通过调试执行程序来执行。

调试执行程序像程序存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存
储临时变量。如果器件不工作——不管什么原因 （如没有振荡器、电源连接故障及目
标板短路等），则调试执行程序将无法与 PICkit 3 在线调试器 / 编程器通信，并且
MPLAB X IDE 会发出一条错误消息。

+5V
+12V

4.7 kΩ

4.7 kΩ

内部电路

程序
存储器

文件
寄存器

内部
调试
寄存器

VPP/MCLR

PGC

PGD

1

5

4

执行程序
调试

调试执行程序 

目标器件

 才能使
必须运行

调试执行
程序正常
运行

为调试执行

VDD

调试执行程序
共用的硬件堆栈

使用的空间

程序保留的 
空间
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获取断点的另一种方式是选择 Debug>Pause （调试 > 暂停）。这会翻转 PGC 和 PGD
线，从而使目标器件的在线调试机制将程序计数器从程序存储器中的用户代码切换到
调试执行程序。同样，目标应用程序暂停， MPLAB X IDE 通过调试器与调试执行程序
的通信来查询目标器件的状态。

2.8 编程

使用 PICkit 3 设备可通过三种方式对器件进行编程：

• 通过 MPLAB X IDE， PICkit 3 连接到 PC。

• 在通过 MPLAB X IDE 设置后，通过 PICkit 3 进行脱机编程。（更多信息，请参见
第 5 章 “PICkit 3 脱机编程”。）

• 通过 PICkit 3 编程器应用程序，一个允许通过 PICkit 3 而不使用 MPLAB X IDE 编
程器件的软件程序。（关于指示信息，请参见 “PICkit 3 Programmer Application 
User’s Guide”。）

使用 PICkit 3 作为编程器，编程实际 （非 -ICE/-ICD）器件，即不在调试头板上的器
件。将 PICkit 3 设置为当前工具 （Edit>Project Properties， Advanced， MPLAB 
Environment）以执行这些操作：

• 当选择 Run>Run Project （运行 > 运行项目）时，应用程序代码通过 ICSP 协议
编程到器件存储器。编程时不需要时钟，可以编程所有的处理器模式，包括代码保
护、使能看门狗定时器和表读保护。

• 一个小的 “编程执行程序”程序被载入到目标器件的程序存储器的高地址段。这
会增加大存储器器件的编程速度。

• 目标器件中的特殊 “在线调试”寄存器及所有调试功能均通过 MPLAB X IDE 禁
止。这意味着不能设置断点，不能查看或更改寄存器内容。

• 目标器件运行在发布模式下。作为编程器，调试器只能通过翻转 MCLR 线来复位
和启动目标器件。

PICkit 3 在线调试器 / 编程器系统使用 ICSP 编程目标器件。 VPP、 PGC 和 PGD 线应
如之前的描述进行连接。编程时不需要时钟，可以编程所有的处理器模式，包括代码
保护、看门狗定时器和表读保护。

2.9 调试器使用的资源

如需器件中调试器所用资源的完整列表，请访问 MPLAB X IDE 的 Start 页，单击
Release Notes and Support Documentation，然后单击 Reserved Resources for PICkit 
3 （为 PICkit 3 保留的资源）链接。
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注：
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第 3 章  调试器使用
3.1 简介

以下主题介绍了如何安装和使用 PICkit 3 在线调试器 / 编程器系统。

• 安装和设置

• 常用调试功能

• 连接目标

• 设置目标板

• 设置 MPLAB X IDE
• 启动和停止调试

• 查看处理器存储器和文件

• 关于编辑器的更多信息，请参见 NetBeans 帮助中的 IDE Basics>Basic File 
Features （IDE 基础知识 > 基本文件特性）。

3.2 安装和设置

关于安装 IDE 和设置调试器以与 IDE 配合使用的详细信息，请参见 “Getting Started 
with MPLAB X IDE”帮助文件。

概述：

1. 安装 MPLAB X IDE。
2. 连接 PICkit 3 到 PC，允许安装默认驱动程序。关于目标连接的更多信息，请参

见第 2 章 “工作原理”。

3. 安装开发时要使用的语言工具套件 / 编译器。

4. 启动 MPLAB X IDE。
5. 使用 New Project （新建项目）向导 （File>New Project）将 “PICkit 3”添加

到项目中。

6. 使用 Project Properties 对话框 （File>Project Properties）设置选项。

7. 使用 Project Properties 对话框 （File>Project Properties<Hardware tool> （文
件 > 项目属性 < 硬件工具 >））设置进行编程的工具选项。

8. 通过 Run>Run Project 运行项目 （编译和运行）。

注意事项：

1. 每个调试器都包含一个唯一标识符，首次安装时，无论使用哪个计算机 USB 端
口都会由操作系统识别。

2. MPLAB X IDE 操作在运行 （运行或调试运行）时连接至硬件工具。为了始终连
接到硬件工具 （例如 MPLAB IDE v8），请参见 Tools>Options （工具 > 选项）
中的 Embedded （嵌入式）按钮，然后在 Generic Settings （通用设置）选项
卡中，选中 Keep hardware tool connected （硬件工具保持连接状态）复选框。

3. 配置位只能在 Configuration Bits （配置位）窗口中查看。要在代码中设置配置
位，选择 Window>PIC Memory Views （窗口 > PIC 存储器视图）。然后，从
Memory （存储器）下拉列表中选择“Configuration Bits”，从 Format （格式）
下拉列表中选择 “Read/Write”（读 / 写）使能访问设置。

注： 调试器只能为目标板提供最高 100 mA 的电流。
 2013 Microchip Technology Inc. DS52116A_CN 第 29 页



MPLAB® X PICkit™ 3 用户指南

D

3.3 常用调试功能

关于调试功能的详细信息，请参见帮助文件“Getting Started with MPLAB X IDE”的  
“Debugging code”（调试代码）部分。此部分包括：

1. 从 Debug>Debug Project 调试运行项目 （编译、编程和运行）。

2. 使用断点

3. 单步执行代码

4. 使用 Watches （观察）窗口

5. 查看存储器、变量和调用堆栈

6. 使用调用图

3.4 连接目标

内置的连接允许选择与目标板的通信类型。更多详细信息和连接图，请参见第 2.4 节
“调试器与目标板之间的通信”。

1. 插入 USB/ 电源电缆 （如果没有连接）。

2. 在调试器和目标之间连接通信电缆 （如果使用 RJ11 插头），或者直接连接到 6
引脚直插式连接头。

图 3-1： 插入通信电缆和 USB/ 电源电缆

PICkit 3

连接到目标板
连接到 PC 或调试头

21

USB 电缆
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3.5 设置目标板

3.5.1 使用生产器件

对于生产器件，调试器可直接连接到目标板。目标板上的器件必须有内置调试电路，
以便 PICkit 3 在线调试器 / 编程器使用它进行调试。要了解器件是否有必需的调试电
路，即必须有一个 “Background Debugger Enable”（后台调试器使能）配置位，请
查阅器件数据手册。

目标板必须有一个连接器，以适合为调试器所选的通信方式。关于连接信息，请参见
第 2.4 节 “调试器与目标板之间的通信”中的 “标准 ICSP 器件通信”。

3.5.2 使用 ICE 器件

对于 ICE 器件，需要 ICE 调试头板。调试头板包含仿真特定器件或器件系列所必需的
硬件。关于 ICE 调试头的更多信息，请参见 “Processor Extension Pak and Header 
Specification”（DS51292）。

将转换插座与 ICE 调试头一起使用，以将调试头连接到目标板。提供了多种类型的转
换插座，以允许通用的调试头能够与某个受支持的表面贴装类型相连。更多关于转换
插座的更多信息，请参见 “Transition Socket Specification”（DS51194）。

调试头或处理器扩展套件的调试头板布线有所不同。如需了解连接信息，请参见第 2.4
节 “调试器与目标板之间的通信”中的 “标准 ICSP 器件通信”。

3.5.3 使用 ICD 调试头

所有低档 PIC 单片机和一些中档 PIC 单片机都需要在调试调试头电路板上安装一个特
殊的 -ICD 器件以使能调试功能。如需这些器件的列表以及所需 ICD 调试头板的部件编
号，请参见 “Processor Extension Pak and Header Specification”（DS51292）。 该
文档可从 www.microchip.com 在线获取。

每个 ICD 调试头板都随附了必需的 -ICD 器件，可用于目标板而非生产单片机。不过，
大多数调试头板都具有 RJ-11 调试连接器，需要使用 AC164110 RJ-11 至 ICSP 适配
器工具包来连接到 PICkit 3。图 3-2 显示了如何配合使用用于 PIC18F45K20 单片机的
AC162061 ICD 调试头和 AC164110 适配器工具包以及低引脚数演示板。

许多中档 PIC 单片机以及所有 PIC18 和 16 位 PIC 单片机不需要 ICD 调试头，可以直
接通过 ICSP 编程连接进行调试。

注： 将来，可使用具有支持 ICD 的电路的器件。

注： 将来，可使用具有 ICD 器件 （器件 -ICD）的 ICD 调试头板。
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图 3-2： 使用 ICD 调试头板

3.5.4 为目标供电

配置要点：

• 当使用 USB 连接时，PICkit 3 可由 PC 供电，但它只能够在 1.8-5V 的 VDD 下为较
小的目标板提供最大 30 mA 的有限大小电流。

• 理想方法是由目标板提供 VDD，因为它可提供较高电流。这样做的另一个优点是
可继承即插即用的目标检测功能，即当 MPLAB X IDE 检测到目标板和器件时，它
将在 Output （输出）窗口显示来通知您。

使用适当的电缆将 PICkit 3 连接到目标板，如果尚未这样做的话 （见第 3.4 节 “连接
目标”）。然后为目标板供电。您也可以通过 PICkit 3 为目标板供电。

注： 目标电压只用于为 ICSP 接口的驱动电路供电；而不能为 PICkit 3 供电。
PICkit 3 电源来自 USB 端口。
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3.6 设置 MPLAB X IDE
连接了硬件并上电后，便可设置 MPLAB X IDE 以配合使用 PICkit 3 在线调试器。

在一些器件上，您必须通过配置位选择通信通道，例如 PGC1/EMUC1 和
PGD1/EMUD1。请确保此处选择的引脚与物理连接到器件的引脚相同。

关于安装软件和设置调试器以配合使用的详细信息，请参见 MPLAB X IDE 帮助。

3.7 启动和停止调试

要在 MPLAB X IDE 中调试应用程序，必须创建一个包含源代码的项目，以便按照如下
所述编译代码、将代码烧写到器件中并执行：

• 选择 Debug>Debug Project 或从 Run （运行）工具栏选择 Debug Project 以运行
代码。

• 选择 Debug>Pause 或从 Debug 工具栏选择 Pause 以暂停代码。

• 选择 Debug>Continue （调试 > 继续）或从 Debug 工具栏选择 Continue 以再次
运行代码。

• 选择 Debug>Step Into （调试 > 单步进入）或从 Debug 工具栏选择 Step Into 以
单步执行代码。注意不要单步进入 Sleep 指令，否则必须执行处理器复位以恢复
仿真。

• 选择 Debug>Step Over （调试 > 单步跳过）或从 Debug 工具栏选择 Step Over
以单步跳过某一代码行。

• 选择 Debug>Finish Debugger Session （调试 > 完成调试器会话）或从 Debug 工
具栏选择 Finish Debugger Session 以结束代码执行。

• 选择 Debug>Reset （调试 > 复位）或从 Debug 工具栏选择 Reset 以对代码执行
处理器复位。根据器件的不同，可能有其他复位 （如 POR/BOR、 MCLR 和系统
复位）。

3.8 查看处理器存储器和文件

MPLAB X IDE 提供了多个窗口来查看调试信息和各处理器存储器信息，可在 Window  
（窗口）菜单中进行选择。关于使用这些窗口的更多信息，请查看 MPLAB X IDE 在线
帮助。

• Window>PIC Memory Views （窗口 > PIC 存储器视图）——查看数据 （RAM）
和代码 （ROM）器件存储器。从 RAM、闪存、特殊功能寄存器 （Special 
Function Register， SFR）、 CPU 和配置位中进行选择。

• Window>Debugging （窗口 > 调试）——查看调试信息。从变量、观察、调用堆
栈、断点和跑表中进行选择。

要查看源代码，在 Projects （项目）窗口中找到要查看的源代码文件并双击以在 Files
（文件）窗口中打开。该窗口中的代码根据所选处理器和编译工具采用不同颜色标识。
要更改颜色标识的样式，在 Tools>Options 的 Fonts & Colors （字体和颜色）中，选
择 Syntax （语法）选项卡。

关于编辑器的更多信息，请参见 NetBeans 帮助中的 IDE Basics>Basic File Features
（IDE 基础知识 > 基本文件特性）。
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第 4 章  PICkit 3 Debug Express
4.1 简介

PICkit 3 Debug Express 工具包与 MPLAB X IDE 应用程序配合使用，可运行、停止和
单步运行程序。可设置一个或多个断点，也可以将处理器复位。处理器停止后，可检
查和修改寄存器的内容。

关于如何使用 MPLAB X IDE 的更多信息，请参考以下文档：

• MPLAB® X IDE 用户指南 （DS51519A_CN）

• MPLAB® X IDE 在线帮助

4.2 PICkit 3 DEBUG EXPRESS 工具包内容

PICkit 3 Debug Express 工具包 （DV164131）包含以下组件：

1. PICkit 3 在线调试器 / 开发编程器

2. USB 电缆

3. 带器件的 44 引脚演示板

4.3 安装硬件和软件

安装 PICkit 3 硬件和软件。

4.3.1 保留的资源

由于 ICD 器件的内置在线调试功能和调试器提供的 ICSP 功能， PICkit 3 Debug 
Express 会在调试时使用一些片上资源。

关于调试器需要的器件资源的完整列表，请参见 MPLAB X IDE 的 Start 页，单击
Release Notes and Support Documentation，然后单击 Reserved Resources for PICkit 
3 链接。

4.3.2 连接至演示板

只需按照图 4-1 所示将演示板连接到 PICkit 3，就可以对 44 引脚演示板上的
PIC18F45K20 进行调试。（也可使用 Explorer 16 开发板进行调试。）

注： PICkit 3 Debug Express 需要 MPLAB X IDE 1.20 版或更高版本。
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图 4-1： 将演示板连接到 PICkit™ 3

4.3.3 配置位和 Debug Express
不需要 ICD 调试头、可直接调试的 PIC 单片机在配置字中含有一个 DEBUG 位，该位
用于使能和禁止 PIC 单片机的调试模式。

使用 PICkit 3 Debug Express 时， MPLAB X IDE 会自动适当地设置该位，所以不应在
源代码配置设置中指定该位。

许多 16 位器件 （例如 PIC24 和 dsPIC33 系列）具有多个 ICSP 编程和调试端口引
脚，标记为 PGC1/EMUC1 和 PGD1/EMUD1、 PGC2/EMUC2 和 PGD2/EMUD2 等。
虽然可以使用任意的 ICSP 端口进行编程，但对于调试，每次只有一个端口处于有效状

态。处于有效状态的 EMU 端口在器件配置位中设置。如果设置的有效端口与 PICkit 3
所连接的 EMU 端口不匹配，器件将无法进入调试模式。在 MPLAB X IDE 
Configuration Bits （配置位）对话框中，这些位通常称为 “Comm Channel Select”
（通信通道选择）位。

警告

在正常情况下，不应在源代码配置设置中指定 DEBUG 配置位的值。如果这样做，可能导致在

脱离调试器对器件进行编程时，该位被置为有效。这会导致该器件在应用电路中无法正常工
作，或者根本不工作。
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第 5 章  PICkit 3 脱机编程
5.1 简介

PICkit 3 脱机编程功能允许将 PIC MCU 存储器映像下载到 PICkit 3，以便稍后编程到
特定 PIC MCU。PICkit 3 编程器设置为脱机编程后，不需要软件或 PC，只需为 PICkit 
3 提供 USB 电源即可编程器件。

此章节讨论的主题为：

• 用于 PICkit 3 脱机编程的 USB 电源

• PICkit 3 脱机编程支持的器件

• 针对脱机编程操作设置 PICkit 3
• 使用 PICkit 3 进行脱机编程

• 退出脱机编程模式

5.2 用于 PICkit 3 脱机编程的 USB 电源

PICkit 3 编程器硬件不能由目标板通过 ICSP 连接器 VDD 引脚完全供电。因此，必须
通过 PICkit 3 设备顶部的 USB 微型 B 端口由 5V 电源供电。可通过如下方法来提供电
源：

• 任何可用的 PC USB 端口或 USB 集线器端口 （仅用于供电，不用于通信）

• 便携式设备的 USB 主机端口

• USB 电源适配器或带 USB 微型 B 连接器的充电器，连接到汽车电源接口或交流
壁式插头

• 便携式电池充电器或电源，用于手机或其他带 USB 微型 B 连接器的便携式设备

• 为 PICkit 3 USB 端口提供 +5V 稳压电源的定制电池组

5.2.1 电源要求

USB 电源应满足以下最低标准：

• 为 PICkit 3 设备最低提供 100 mA 电流

• 提供稳定的 4.5-5.5V 稳压输出

注： 虽然 PICkit 3 设备支持编程和调试功能，但当使用脱机编程功能时，仅可
编程。脱机编程时不能使用任何调试功能。

注 1： 大多数自带电池的便携式充电器 / 电源设备在其内部电池电压变低，输出
跌落到 4.5V 以下时，不会提供指示信息。因此，必须确保设备电池有足
够的剩余能量以为 PICkit 3 提供 4.5V 以上的电源。

2： 在不使用时，任何电池电源都应与 PICkit 3 设备断开连接。否则 PICkit 3
设备将耗尽电源电池。
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5.3 PICkit 3 脱机编程支持的器件

以下系列的所有器件通过 MPLAB X IDE 受 PICkit 3 支持，同样也为脱机编程操作所支
持。表 5-1 列出了支持的器件系列和程序存储器限制。

表 5-1： 脱机编程支持的器件

支持的系列 支持的器件

低档 所有 1

中档 所有 1

PIC18F 所有 1

PIC18 J 系列 所有 1

PIC18 K 系列 所有 1

PIC24 所有 1,2

dsPIC33 所有 1,2

dsPIC30 所有 1

dsPIC30 SMPS 所有 1

PIC32 所有

注 1： 支持 MPLAB X IDE 支持的所有器件系列。请参见 MPLAB X IDE 的 Start
页，单击 Release Notes and Support Documentation 链接，然后单击
Device Support.htm 查看应用支持的器件列表。支持大存储器器件。

2： 对于这些器件， PICkit 3 脱机编程不支持使用编程执行程序 （增强型
ICSP）。当使用 PICkit 3 对这些器件进行脱机编程时，将使用低级 ICSP
方法对这些器件编程。
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5.4 针对脱机编程操作设置 PICkit 3
在将存储器映像下载到 PICkit 3 用于脱机编程功能之前，应按照脱机编程操作需要设
置 PICkit 3 编程器软件选项和缓冲区。实际上，强烈建议在下载映像以进行脱机编程之
前，首先使用所需选项通过软件编程目标器件进行测试，确保按预期编程器件。关于
使用 MPLAB X IDE 编程器件的信息，请参见 MPLAB X IDE 在线帮助。

5.4.1 设置脱机编程

在 MPLAB X IDE 上，按照这些步骤设置脱机编程选项：

1. 单击项目，选择 File>Project Properties。在 Hardware Tool 区域，单击需要在
项目中使用的 PICkit 3 序列号 （SN）。单击 Apply （应用）。

图 5-1： PICkit™ 3 项目属性

2. 在左侧对话框的 Categories （类别）下，单击 “PICkit 3”。现在，您可从
Options categories （选项类别）下拉菜单中选择 “Programmer To Go”。请参
见图 5-2。

注： PICkit 3 不是生产编程器。应该仅用作开发目的。脱机编程操作为现场环境
提供编程可移植性，而不是为了生产目的。

注： 保留存储器选项在脱机编程模式下不受支持。
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3. 在 “Image Name”（映像名称）字段中，输入要用于编程映像的名称。

图 5-2： 命名映像

4. 单击图 5-3 中显示的 Programmer To Go 选项卡，显示您为编程器件选择的设
置。如果想改变任何设置，请使用 Project Properties 对话框。

图 5-3： Programmer To Go 选项卡

5. 单击 OK （确定）。
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5.4.2 完成下载至 PICkit 3
使用 Make and Program Device （编译并编程器件）图标旁边的向下箭头，选择
“Programmer To Go PICkit3”（见图 5-4）执行至 PICkit 3 设备的映像传送。映像存
储到 PICkit 3 后，您无需使用 MPLAB X IDE 或 PC 编程器件。可将 PICkit 3 放置在其
他没有计算机的地方，通过按钮编程器件。

图 5-4： 下载至 PICkit™ 3

下载映像后，下载完成时 Output 窗口将显示一条消息：

“PICkit 3 is now in Programmer to go mode. The next time you connect to this 
unit, you will have the choice to take it out of Programmer to go mode”（PICkit 3
现在处于脱机编程模式。下次连接到此设备时，您可选择退出脱机编程模式。）

PICkit 3 设备的 “Active” LED 应闪烁，指示处于脱机编程模式，可以编程。

从 PC USB 端口断开 PICkit 3 连接。当施加任何 USB 电源时， PICkit 3 设备上电后将
处于脱机编程模式，通过闪烁的 “Active” LED 指示。
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5.5 使用 PICkit 3 进行脱机编程

使用 PICkit 3 脱机编程功能编程目标器件 （设置后），按照以下步骤执行。

1. 按照第 5.2 节 “用于 PICkit 3 脱机编程的 USB 电源”所述，将 USB 电源连接
到 PICkit 3 设备。

2. 确保 PICkit 3 “Power” LED 点亮。“Active” LED 闪烁一次，指示设备处于脱
机编程模式，可以编程。

3. 将 PICkit 3 设备 ICSP 连接器连接到目标板。确保目标板正确供电 （如果没有由
PICkit 3 供电）。

4. 按 PICkit 3 按钮开始编程。

编程操作期间，当执行操作时 PICkit 3 “Status” LED 显示橙色并且保持点亮。

当完成编程操作时， PICkit 3 设备通过设备 LED 提供操作反馈。绿色 “Status” LED
指示操作成功。红色指示编程失败。反馈代码请参见表 5-2。

表 5-2： 脱机编程操作反馈代码

LED 状态 解释

“Active”
LED

“Status”
LED 代码 说明

蓝色
单次闪烁

绿色 成功 / 就绪 编程操作期间没有遇到错误。
PICkit 3 脱机编程功能可再次进行编程。

熄灭 红色

连续快速闪烁：
••••••••••••••

VDD/VPP 错误 PICkit 3 不能将 VDD 或 VPP 电压设置为期望
值。 
如果 PICkit 3 没有提供 VDD，则一定是 VPP
错误。
VDD 和 VPP 信息，请参见第 2.5 节“通信
连接”。

熄灭 红色
连续的 2 次
闪烁：

•• •• •• •• ••

器件 ID 错误 PICkit 3 从目标器件接收到异常器件 ID。
设置 PICkit 3 脱机编程后，检查目标器件是
否与选择的器件匹配。此错误可能指示错误
ICSP 连接阻止 PICkit 3 与目标器件通信。
不适用于低档器件。

熄灭 红色
连续的 3 次
闪烁：
••• ••• ••• •••

校验错误 目标器件在编程后没有成功通过校验。
确保目标 VDD 满足最低要求。对于低档器
件，此错误可能指示 ICSP 通信问题。

熄灭 红色
连续的 4 次
闪烁：
•••• •••• ••••

内部错误 发生了意外内部脱机编程错误。
如果是第二次发生，请尝试再次下载到
PICkit 3。

注： 按 PICkit 3 按钮清除错误代码，启动新的编程操作。
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5.6 退出脱机编程模式

要退出脱机编程模式，请将 PICkit 3 设备插入到 PC USB 端口，并且连接到 MPLAB X 
IDE。选择 Run>Run Project，会显示以下消息：

“PICkit 3 is in Programmer-to-go mode. The name of the stored image is: ____. 
Do you want to stay in Programmer-to-go mode? (Saying no will erase the image 
in the PICkit 3.)”（PICkit 3 处于脱机编程模式。保存的映像名称为： ____。您希
望留在脱机编程模式吗？ （选择否将擦除 PICkit 3 中的映像。））

选择 No （不）擦除映像，退出脱机编程模式。
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第 6 章  故障诊断首要步骤
6.1 简介

如果 PICkit 3 在线调试器 / 编程器在工作过程中出现问题，请从此处开始故障诊断。

• 需要先回答的 5 个问题

• 不能调试的头 13 个原因

• 需要考虑的其他事项

6.2 需要先回答的 5 个问题

1. 使用的是哪款器件？
要支持新的器件，通常要求将 MPLAB X IDE 升级到较新的版本。也就是说，黄
灯 = 未测试是否支持。

2. 您使用的是 Microchip 的演示板还是您自己设计的电路板？
您是否遵守了通信连接的电阻 / 电容的连接准则？请参见第 2 章 “工作原理”。

3. 您是否已为目标板供电？
调试器无法为目标板提供大于 30 mA 的电流。

4. 在安装过程中您是否使用了 USB 集线器？它是否已上电？
如果仍有问题，请尝试不使用集线器来连接调试器和 PC，而是将调试器直接插
入 PC。

5. 您是否使用了随调试器一起提供的标准通信电缆 （RJ-11）？
如果您使用了更长的电缆，则可能导致通信错误。

6.3 不能调试的头 13 个原因

1. 振荡器不工作。 
检查振荡器的配置位设置。如果您在使用外部振荡器，请尝试使用内部振荡器。 
如果您在使用内部 PLL，请确保您的 PLL 设置正确。

2. 目标板未上电。
检查电源电缆连接。

3. VDD 电压超出该器件规范。
更多详细信息，请参见器件编程规范。

4. 调试器已断开与 PC 和 / 或目标板的物理连接。
检查通信电缆的连接。

5. 器件受到代码保护。
检查代码保护的配置位设置。

6. 调试器与 PC 的通信已中断。
在 MPLAB X IDE 中重新连接到调试器。
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7. 尝试调试的生产器件没有调试功能。
请使用调试头代替。（请参见 “推荐读物”中的 “Processor Extension Pak 
and Header Specification”）。

8. 目标应用程序损坏或包含错误。
例如，项目中使用了常规链接描述文件，而不是调试器版本的链接描述文件（例
如，使用了 18F8722.lkr，而不是 18F8722i.lkr）。尝试重新编译和重新烧写目标应
用程序。然后对目标器件启动上电复位。

9. 没有在配置位中编程正确的 PGC/PGD 引脚对 （对于带多个 PGC/PGD 引脚对
的器件）。

10. 其他干扰调试的配置设置。  
任何阻止目标器件执行代码的配置设置同样会阻止调试器将代码置于调试模式。

11. 欠压检测电压大于工作电压 VDD。 
这意味着器件处于复位状态，不能调试。

12. 没有遵循第 2 章 “工作原理”中的通信连接准则。

13. 调试器无法始终执行请求的操作。 
例如，如果目标应用程序当前正在运行，则调试器无法设置断点。

6.4 需要考虑的其他事项

1. 错误也许是个一次性问题。 
再次尝试操作。

2. 通常，编程可能会出现问题。 
作为测试，切换为运行模式，然后向目标器件烧写一个尽可能简单的应用程序
（例如，使 LED 闪烁的程序）。如果程序没有运行，则说明目标设置存在错误。

3. 目标器件很可能因某种原因 （如过流）遭到损坏。 
开发环境明显对元器件不利。请考虑尝试其他目标器件。

4. Microchip Technology Inc. 提供了各种演示板来支持大部分单片机。 
请考虑使用这些已知正常工作的其中一个演示板来验证 PICkit 3 在线编程器 / 调
试器的功能是否正常。 

5. 查看调试器操作以确保应用设置正确。 
更多信息，请参见第 2 章 “工作原理”。

6. 如果问题依然存在，请联系 Microchip。
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第 7 章  常见问题解答（FAQ）
7.1 简介

本章提供有关 PICkit 3 在线调试器 / 编程器系统的常见问题的解答。

• 工作原理

• 出现的问题

7.2 工作原理

• 芯片中的什么部件允许其与 PICkit 3 在线调试器 / 编程器通信？

PICkit 3 在线调试器 / 编程器通过 ICSP 接口与闪存芯片通信。它使用下载到程序
或测试存储区中的调试执行程序。

• 必须运行调试执行程序对处理器吞吐量会有什么影响？

运行模式下，调试执行程序并不运行，因此在运行代码时不会降低吞吐量，即调试
器不会占用目标器件的任何周期。

• PICkit 3 在线调试器 / 编程器与其他在线仿真器 / 调试器相比有何不同？

请参见第 2.2 节 “工具比较”。

• PICkit 3 在线调试器 / 编程器是否与其他在线仿真器 / 调试器一样具有复杂断点？

否。但您可以根据数据存储单元或程序地址单元中的值来实现中断。

• PICkit 3 是否采用光电隔离或电气隔离？

否。不能对当前系统施加悬浮电压或高电压 （120V）。

• 标准电缆存在哪些限制 ?
标准 ICSP RJ-11 电缆不允许超过 15 Mbps 的时钟速度。

• PICkit 3 是否会降低程序的运行速度 ?
不会，器件将以器件数据手册中指定的任何速度运行。

• 可以调试以任何速度运行的 dsPIC DSC 吗？

PICkit 3 能够以器件数据手册中指定的任何器件速度进行调试。

• 引脚 6 （LVP 引脚）具有什么功能？

引脚 6 保留用于 LVP （低电压编程）连接。
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7.3 出现的问题

• 编程器件后，执行校验失败。这是编程问题吗？

选择 “Run”（Run>Run Program）时，器件将在编程后立即自动运行。因此，
如果代码对闪存存储器进行了更改，校验可能会失败。要阻止代码在编程后立即运
行，请选择 “Hold in Reset”（保持复位）。

• 我的 PC 进入掉电 / 休眠模式，并且现在调试器无法工作。这是怎么回事？

长时间使用调试器时 （尤其是用作调试器时），请确保在 PC 操作系统的 “电源
选项”对话框窗口中禁止休眠模式。跳转到 “休眠”选项卡，清除或取消选中
“启用休眠”复选框。这可确保在所有 USB 子系统组件之间保持所有通信。

• 我已将外设设置为暂停时不冻结，但它却突然发生冻结。这是怎么回事？

对于 dsPIC30F/33F 和 PIC24F/H 器件，外设控制寄存器中的一个保留位 （通常
为 bit 14 或 bit 5）由调试器用作冻结位。如果您对整个寄存器执行过写操作，那
么您可能改写了此位。（在调试模式下用户可访问此位。）

为避免上述问题，请只在应用程序中对想要更改的位执行写操作 （通过 BTS和
BTC），而不是对整个寄存器执行写操作 （通过 MOV）。

• 使用 16 位器件时，发生了意外复位。如何确定复位的原因？

考虑以下几个方面：

- 要确定复位源，请检查 RCON 寄存器。

- 在中断服务程序 （Interrupt Service Routine， ISR）中处理陷阱 / 中断。应包
括 trap.c样式的代码，即：

   void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- 使用 ASSERT。
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• 我已调试完代码。现在也已编程了器件，但是器件不运行。这是怎么回事？

考虑以下几个方面：

- 您是否已将调试器选作编程器，然后尝试编程调试头板？调试头板包含
-ICE/-ICD 版本的器件，并且可能不会像实际器件那样运行。在将调试器选作
编程器时，仅编程那些 “常规”器件。常规器件为具有内置 -ICE/-ICD 电路的
器件，但不是调试头板上的特殊 -ICE/-ICD 器件。

- 您是否已将调试器选作调试器，然后尝试编程生产器件？当调试器用作调试器
时，编程器件会将调试执行程序烧写到程序存储器并为调试设置其他器件功能
（见第 2.7.1 节 “进入调试模式的操作序列”）。要烧写最终 （发布）代码，
请将调试器选作编程器。

- 您是否已从 Build Configuration （编译配置）下拉列表或项目菜单中选择了
“Release”（发布）？您必须对最终 （发布）代码执行此操作。重新编译项
目、重新编程器件，并尝试再次运行代码。

• 如何手动下载固件 ?
您可以手动下载固件。选择 File>Project Properties。在 Categories 下，单击
“PICkit 3”，并从 Option Categories （选项类别）下拉菜单中选择
“Firmware”（固件）。取消选中 “Use Latest Firmware”（使用最新固件）并
单击 “Press to browse for a specific firmware version”（单击以浏览至特定固
件版本）。浏览 Directories （目录）窗格中
MPLABX\mplab_ide\mplablibs\modules\ext\PICKIT3.jar 下的固件文件。在
Firmware Files 窗格 （固件文件）中，选择您需要的 .jam文件，然后单击
OK。在 Project Properties 对话框中单击 Reset （复位）。

• 下载固件时意外断开了 PICkit 3 的连接。该怎么办？

重新连接 PICkit 3。它将开始擦除已写入的内容，以便重新启动。该擦除操作将
持续约 7 秒。请耐心等待。 LED 在此过程中全部点亮。擦除完成时，MPLAB X 
IDE 将识别器件并启动恢复过程，即开始下载固件。

• 存储器窗口不反映变化

要在窗口中看到变化，必须对存储器执行读操作。

• 在这里找不到我遇到的问题。该怎么办？

请尝试下列资源：

- 第 2.9 节 “调试器使用的资源”

- 第 8.3 节 “常规纠正措施”

- 第 8.2 节 “特殊错误消息”

- 第 9 章 “工程技术说明 （ETN）”
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第 8 章  错误消息
8.1 简介

PICkit 3 在线调试器 / 编程器会产生各种不同的错误消息；其中一些错误消息比较特殊
而其他的都可以用常规纠正措施解决。通常，请阅读错误消息下面的所有指示信息。
如果仍未解决问题或者无指示信息，请参见以下章节。

• 特殊错误消息

• 常规纠正措施

8.2 特殊错误消息

8.2.1 调试器到目标器件的通信错误

Failed to send database （无法发送数据库）

如果收到这个错误：

1. 尝试重新下载。该错误可能只发生一次。

2. 尝试手动下载编号最高的 .jam文件。

如果这些措施无法解决问题，请参见第 8.3.2 节 “调试器到目标器件的通信错误纠正
措施”。

8.2.2 损坏 / 过时安装错误

Failed to download firmware （无法下载固件）

如果存在 Hex 文件：

• 重新连接并重试。

• 如果无法解决问题，则表明该文件可能已损坏。重新安装 MPLAB X IDE。
如果不存在 Hex 文件：

重新安装 MPLAB X IDE。
Unable to download debug executive （无法下载调试执行程序）

如果尝试调试时收到此错误：

1. 取消将调试器选作调试工具。

2. 关闭项目，然后关闭 MPLAB X IDE。
3. 重新启动 MPLAB X IDE，然后重新打开项目。

4. 选择调试器作为调试工具并再次尝试调试目标器件。

Unable to download program executive （无法下载编程执行程序）

如果尝试编程时收到此错误：

1. 取消将调试器选作编程器。

2. 关闭项目，然后关闭 MPLAB X IDE。
3. 重新启动 MPLAB X IDE，然后重新打开项目。

4. 将调试器选作编程器并尝试重新编程目标器件。

如果这些措施无法解决问题，请参见第 8.3.4 节 “安装损坏纠正措施”。
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8.2.3 调试失败错误

The target device is not ready for debugging. Please check your configuration bit 
settings and program the device before proceeding.（目标器件未准备好调试。请
检查配置位设置并编程器件，然后继续。）

当您尚未编程器件就尝试运行时将收到此消息。如果在编程器件后尝试运行时收到此
消息，或者在编程器件后立即收到此消息，请参见第 8.3.6 节 “调试失败纠正措施”。

器件受到代码保护。

您尝试进行操作 （读、编程、空白检查或校验）的器件受到代码保护，即，无法读或
修改代码。检查配置位设置，看是否使能了代码保护。

要禁止代码保护，请根据器件数据手册，在代码或 Configuration Bits 窗口中置 1 或清
零相应的配置位。然后擦除并重新编程整个器件。

8.2.4 其他错误

PICkit 3 is busy. Please wait for the current operation to finish. （PICkit 3 忙。请
等待当前操作完成。）

如果在尝试取消将调试器选作调试器或编程器时收到此错误：

1. 等待——使调试器有时间完成任何应用程序任务。然后重新尝试取消选择调试
器。

2. 选择 Halt （暂停）来停止所有运行中的应用程序。然后重新尝试取消选择调试
器。

3. 将调试器从 PC 上拔下。然后重新尝试取消选择调试器。

4. 关闭 MPLAB X IDE。

8.3 常规纠正措施

以下常规纠正措施可解决您遇到的问题：

• 读 / 写错误纠正措施

• 调试器到目标器件的通信错误纠正措施

• 调试器到 PC 的通信错误纠正措施

• 安装损坏纠正措施

• USB 端口通信错误纠正措施

• 调试失败纠正措施

• 内部错误纠正措施

8.3.1 读 / 写错误纠正措施

如果收到读或写错误：

1. 是否按下了 Abort （中止）？此操作可能产生读 / 写错误。

2. 重试操作。该错误可能只发生一次。

3. 确保目标器件已上电并且器件的电压正确。有关所需器件电压，请参见器件数据
手册。

4. 确保调试器到目标器件的连接正确 （PGC 和 PGD 已连接）。

5. 对于写错误，确保在 Settings 对话框的 Program Memory （程序存储器）选项
卡上选中 “Erase all before Program”（编程前擦除所有存储区）。

6. 确保所使用的电缆的长度正确。
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8.3.2 调试器到目标器件的通信错误纠正措施

PICkit 3 在线调试器 / 编程器与目标器件互不同步。

1. 选择 Reset，然后重试操作。

2. 确保所使用的电缆的长度正确。

8.3.3 调试器到 PC 的通信错误纠正措施

PICkit 3 在线调试器 / 编程器与 MPLAB X IDE 互不同步。

1. 拔下调试器，然后重新插入。

1. 重新连接到调试器。

2. 重试操作。该错误可能只发生一次。

3. 所安装的 MPLAB X IDE 版本可能与 PICkit 3 在线调试器 / 编程器上加载的固件
版本不一致。请按照第 8.3.4 节 “安装损坏纠正措施”中所述的步骤进行操作。

8.3.4 安装损坏纠正措施

该问题很可能是由于 MPLAB X IDE 的安装不完整或者损坏引起的。

1. 卸载 PC 上所有版本的 MPLAB X IDE。
2. 重新安装所需的 MPLAB X IDE 版本。

3. 如果问题仍然存在，请联系 Microchip。

8.3.5 USB 端口通信错误纠正措施

该问题很可能是由于通信端口错误或者不存在引起的。

1. 重新连接到 PICkit 3 在线调试器 / 编程器。

2. 确保调试器已物理连接到 PC 上适当的 USB 端口。

3. 确保在调试器设置中选择了适当的 USB 端口。

4. 确保 USB 端口未被其他器件使用。

5. 如果要使用 USB 集线器，请确保集线器已上电。

6. 确保已加载 USB 驱动程序。

8.3.6 调试失败纠正措施

PICkit 3 在线调试器 / 编程器无法执行调试操作。引发此错误的原因很多。请参见第
6.3 节 “不能调试的头 13 个原因”和第 6.4 节 “需要考虑的其他事项”。

8.3.7 内部错误纠正措施

内部错误通常难以预料并且不应该发生。它们主要用于 Microchip 内部开发。

最可能的原因是安装损坏 （第 8.3.4 节 “安装损坏纠正措施”）。

另一个可能的原因是系统资源不足。

1. 尝试重新启动系统以释放存储器。

2. 确保硬盘上有合理的可用空间 （而且不是过多的磁盘碎片）。

如果问题仍然存在，请联系 Microchip。
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第 9 章  工程技术说明（ETN）
以下 ETN 与 PICkit 3 相关。请访问我公司网站 （www.microchip.com）的 “PICkit 3 
In-Circuit Debugger”页面，并单击 “Downloads”（下载）部分中的 ETN 获取详细
信息。

• ETN-32 PICkit 3 Operation at Low Voltage - Modification：适用于组装编号为
10-00424-R4 或更低的 PICkit 3。
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附录 A 硬件规范
A.1 简介

本章详述了 PICkit 3 在线调试器 / 编程器系统的硬件和电气规范。

A.2 重点

本章讨论了：

• 一致性声明

• USB 端口 / 电源

• PICkit 3 在线调试器 / 编程器

• 标准通信硬件

• 目标板注意事项

A.3 一致性声明

我公司

Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona 85224-6199
USA

特此声明：

假设 PICkit 3 在线调试器 / 编程器

符合操作手册中列出的限制，则该产品符合如下标准：

标准：EN61010-1 实验室设备
Microchip Technology, Inc.
日期：2009 年 1 月

关于使用 PICkit 3 在线调试器 / 编程器的重要信息

用户应当了解，基于 PICkit 3 在线调试器 / 编程器的特性，它所产生的电磁辐射会超过
正常水平，从而会对各种类型的射频和其他设备产生干扰。

为了符合欧洲认证法规，必须满足如下限制：

1. 只有在工业环境 （或同等坏境）中使用该开发系统。

2. 禁止在距离可能会受到此类辐射干扰的任何设备 （射频接收器和电视机等） 20
米以内的范围使用该系统。
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A.4 USB 端口 / 电源

PICkit 3 在线调试器 / 编程器通过符合 USB 2.0 版本的微型通用串行总线 （Universal 
Serial Bus， USB）端口与主机 PC 连接。 USB 连接器位于调试器主机的顶部。

系统能够通过 USB 接口重载固件。

通过 USB 接口为系统供电。根据 USB 规范，该调试器被归类为高功耗系统，并且需
要通过 USB 提供略大于 100 mA 的电流，以使该调试器能在所有工作模式 （调试器 /
编程器）下正常工作。

电缆长度——在调试器工具包里提供了正常工作所需长度的 PC 至调试器电缆。

自供电的集线器——如果您想使用 USB 集线器，请确保它是自供电的。而且， PC 键
盘上的 USB 端口不能为调试器正常工作提供足够的功率。

PC 休眠／掉电模式——禁止 PC 上的休眠或其他省电模式，以确保与调试器的正常
USB 通信。

A.5 PICkit 3 在线调试器 / 编程器

调试器包含封装在外壳中的主电路板，带有一个 USB 连接器和一个单列直插式连接
器。调试器外壳上有指示灯 （LED）。

A.5.1 主电路板

主电路板由用于与 PC 进行通信并从 PC 获得电源的 USB 2.0 电路、用于控制通过
ICSP 端口对目标器件进行调试和编程的单片机、用于存储数据和指针的串行
EEPROM 存储器、用于存储脱机编程代码映像的串行 EEPROM 存储器和 LED 指示
灯构成。

A.5.2 指示灯 （LED）

指示灯具有如下含义。

注： PICkit 3 在线调试器 / 编程器通过其 USB 连接供电。目标板自己供电。另
外， PICkit 3 仅可在目标板消耗的电流小于 30 mA 的情况下为目标板供
电。

LED 颜色 说明

Power 绿色 在刚上电或与目标板连接时点亮。

Active 蓝色 PICkit™ 3 已与 PC 建立通信或正在发送 / 接收命令时点亮。

Status 绿色 在调试器正常工作 （待机）时点亮。

橙色 忙时点亮。

红色 调试器操作失败时点亮。
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A.6 标准通信硬件

要使调试器与目标板之间进行标准通信 （第 2.4 节 “调试器与目标板之间的通信”中
的 “标准 ICSP 器件通信”），应使用具有 RJ-11 连接器的适配器。

要在此类型的通信中使用调试头板，您需要一个针对器件的处理器套件，它包括一个
包含所需 ICE/ICD 器件的 8 引脚连接器调试头和一个标准适配器板。

更多关于调试头板的信息，请参见 “Processor Extension Pak and Header 
Specification”（DS51292）。

A.6.1 标准通信

标准通信接口是与目标处理器的主要接口。它包含与高电压 （VPP）和 VDD 检测线的
连接，以及烧写和连接目标器件所需的时钟和数据连接。

VPP 高电压线可生成电压范围为 1.8V 至 14V 的可变电压，以满足特定仿真处理器的
电压要求。

VDD 检测连接从目标处理器汲取电流。

时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号处于高阻模式（即使在未向 PICkit 3 在线调试器 / 编程器系统施加
电源时也是如此）。

• 时钟和数据信号可免受因目标系统故障或连接不当引起的高电压的影响。

• 时钟和数据信号可免受样机或目标系统中的电气短路引起的大电流的影响。

图 A-1： 6 引脚标准引脚排列

注： 以前的调试头板使用 6 引脚 （RJ-11）连接器，而非 6 引脚 SIL 连接器，
所以这些调试头可以直接连接到调试器。

1

2

3

4

5

6

引脚 名称 功能

1  MCLR/VPP  电源

2  VDD_TGT  目标板上的电源

3  GND  地
4  PGD （ICSPDAT）  标准通信数据

5  PGC （ICSPCLK）  标准通信时钟

6  PGM （LVP）  低电压编程

目标板
的底部

标准插座

     目
标

板

    目
标
器

件
 或

P
IM
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A.6.2 模块化电缆和连接器

在标准通信中使用模块化电缆连接调试器和目标应用。下面列出了有关电缆及其连接
器的规范。

A.6.2.1 模块化连接器规范

• 制造商，部件编号——AMP Incorporated， 555165-1
• 代理商，部件编号——Digi-Key， A9031ND
图 A-2 中的表显示了某个应用中的模块化连接器引脚与单片机引脚的对应关系。这种
配置提供了全部的 ICD 功能。

图 A-2： 目标板的模块化连接器引脚排列

模块化连接器引脚 单片机引脚

6 PGM （LVP）
5 RB6

4 RB7

3 地

2 目标器件的 VDD

1 VPP
1

6

目标板上模块化连接器引脚排列

的底视图

1 6

目标板上模块化连接器的正视图

目标板
转换插座

器件 -ICE

AC164110
适配器

调试头

电源

PICkit 3

连接到 PC
的微型 USB
电缆
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A.6.2.2 模块化插头规范

• 制造商，部件编号——AMP Incorporated， 5-554710-3
• 代理商，部件编号——Digi-Key， A9117ND

A.6.2.3 模块化电缆规范

• 制造商，部件编号——Microchip Technology， 07-00024

A.7 目标板注意事项

应根据所选器件 （1.8V-5.0V）和应用的要求向目标板供电。

根据使用的调试器 - 目标板通信类型，目标板电路应考虑以下注意事项：

• 第 2.5.2 节 “目标板连接电路”

• 第 2.5.5 节 “影响调试器正常运行的电路”
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附录 B PICkit 3 原理图
本附录给出了 PICkit 3 在线编程器 / 调试器的原理图。演示板原理图可在相应的用户指南中找到。

图 B-1： PICkit™ 3 原理图 （第 1 页，共 2 页）
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图 B-2： PICkit™ 3 原理图 （第 2 页，共 2 页）
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附录 C 版本历史
版本 A （2013 年 4 月）

这是本文档的初始版本。
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术语表
A
ANSI

美国国家标准学会，是美国负责制订和批准标准的组织。

ASCII

美国信息交换标准码是使用 7 个二进制位来表示每个字符的字符集编码。它包括大写
和小写字母、数字、符号以及控制字符。

B
八进制 （Octal）
使用数字 0 - 7、以 8 为基数的计数体制。最右边的位表示 1 的倍数，右边第二位表示
8 的倍数，右边第三位表示 64 （82）的倍数，以此类推。

本机数据大小 （Native Data Size）
对于本机跟踪， Watches 窗口中使用的变量长度必须与所选器件的数据存储器长度相
同：对于 PIC18 器件，为字节长度；对于 16 位器件，为字长度。

编译 （Build）

编译并链接一个应用程序的所有源文件。

编译堆栈 （Compiled Stack）
编译器管理的存储区域，静态分配变量的空间。当在目标器件上无法高效实现此类机
制时，编译堆栈将替代软件或硬件堆栈。

编译器 （Compiler）
将用高级语言编写的源文件翻译成机器码的程序。

表达式 （Expression）
被算术或逻辑操作符分隔开的常量和 / 或符号的组合。

标识符 （Identifier）
函数名或变量名。

C
C\C++

C 语言是具有表达式简练、先进的控制流程和数据结构，以及运算符丰富等特点的通
用编程语言。 C++ 是 C 语言的面向对象版本。

COFF

公共目标文件格式。此格式的目标文件包含机器码、调试信息和其他信息。
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CPU

请参见中央处理单元。

操作码 （Opcode）
操作码。请参见助记符。

插件 （Plug-in）
MPLAB IDE/MPLAB X IDE 具有内置组件和插件模块，用于针对各种软件和硬件工具
来配置系统。可在 Tools （工具）菜单下找到几个插件工具。

程序存储器 （Program Memory）
MPLAB IDE/MPLAB X IDE——器件中存储指令的存储区。也指仿真器或软件模拟器中
包含已下载的目标应用固件的存储器。

16 位汇编器 / 编译器——器件中存储指令的存储区。

程序计数器 （Program Counter）
包含当前执行指令地址的地址单元。

程序计数器单元 （Program Counter Unit）
16 位汇编器——程序存储器构成的概念化表示。对于每个指令字，程序计数器递增
2。在可执行段中， 2 个程序计数器单元等同于 3 个字节。在只读段中， 2 个程序计数
器单元等同于 2 个字节。

持久性数据 （Persistent Data）
永不清除或初始化的数据。它主要用于使应用在器件复位时依然能保存数据。

重定位 （Relocation）
链接器执行的过程，会将绝对地址分配给可重定位段，并且可重定位段中的所有符号
都会更新为相应的新地址。

触发输出 （Trigger Output）
指可在任意地址或地址范围生成的仿真器输出信号，与跟踪和断点的设置无关。可设
置任意个触发输出点。

次数计数器 （Pass Counter）
每次发生一个事件 （如执行特定地址处的一条指令）时都会递减 1 的计数器。当次数
计数器的值为零时，事件满足。可将次数计数器分配给中断 （break）和跟踪逻辑，以
及在 Complex Trigger （复杂触发）对话框中的任何连续事件。

存储类别 （Storage Class）
决定与所标识对象相关的存储区的存在时间。

存储限定符 （Storage Qualifier）
指示所声明对象的特殊属性 （例如 const）。

存储器模型 （Memory Model）
对于 C 编译器，为应用程序可使用的存储区的表示。对于 PIC18 C 编译器，为一种描
述，指定指向程序存储器的指针的大小。

错误 / 错误文件 （Error/Error File）
错误报告使程序不能继续处理的问题。而且，当问题比较明显时，错误还尽可能标识
出源文件名和行号。错误文件包含由语言工具生成的错误消息和诊断信息。
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D
DWARF

使用任意记录格式调试。 DWARF 是用于 ELF 文件的调试信息格式。

带序列号的快速批量编程 （Serialized Quick Turn Programming）
序列化允许您利用器件编程器将序列号编程到每个单片机中。该序列号可用作入口代
码、密码或 ID 编号。

单步执行 （Single Step）
这一命令单步执行代码，一次执行一条指令。执行每条指令后， MPLAB IDE/MPLAB 
X IDE 更新寄存器窗口、观察变量及状态显示，使您可分析和调试指令。也可单步执行
C 编译器源代码，但不是每次执行一条指令， MPLAB IDE/MPLAB X IDE 将执行一行
高级 C 语句生成的所有汇编指令。

单步跳出 （Step Out）
Step Out 允许跳出当前正在执行的子程序。此命令执行子程序中剩下的代码，然后在
子程序的返回地址处停止执行。

单步跳过 （Step Over）
Step Over 允许单步调试代码并在执行时跳过子程序。当单步跳过一条 CALL指令时，
下一个断点将设置在 CALL指令后的下一条指令处。如果由于某种原因，子程序陷入
无限循环或不正确返回，下一个断点将永远执行不到。除处理 CALL指令外， Step 
Over 命令和 Single Step 相同。

单步进入 （Step Into）
这一命令与 Single Step 相同。 Step Into （与 Step Over 相对）在 CALL指令后，单步
执行子程序。

单片机 （Microcontroller）
高度集成的芯片，它包括 CPU、 RAM、程序存储器、 I/O 端口和定时器。

单片机模式 （Microcontroller Mode）

PIC18 单片机的一种程序存储器配置。在单片机模式下，仅允许内部执行。因此，在

这种模式下仅可使用片内程序存储器。

递归 （Recursion）
已定义的函数或宏可调用自身的概念。编写递归宏时要特别小心；当递归没有出口时
容易陷入无限循环。

递归调用 （Recursive Call）
直接或间接调用自身的函数。

导出 （Export）
以标准的格式将数据发送出 MPLAB IDE/MPLAB X IDE。
导入 （Import）
从外面的源 （如 hex 文件）将数据送入 MPLAB IDE/MPLAB X IDE。
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地址 （Address）
标识存储器中位置的值。

段 （Section）
相当于 GCC 的 OCG 程序段。被链接器视为整体的代码或数据块。

段属性 （Section Attribute）
属于段的 GCC 特性 （如 access段）。

断点 （Breakpoint）
硬件断点：一个事件，执行这种事件会导致暂停。

软件断点：一个地址，固件会在这个地址处暂停执行。通常由特殊的 break 指令获得。

断点逻辑与 （ANDed Breakpoint）
为中断设置逻辑与条件，即只有断点 1 和断点 2 同时出现时，才会暂停程序。只有数
据断点和程序存储器断点同时出现时，才会完成此操作。

堆 （Heap）
用于动态存储器分配的存储区，其中的存储器块按运行时确定的任意顺序进行分配和
释放。

堆栈，编译 （Stack, Compiled）
编译器管理和分配的存储区，静态分配变量的空间。当在目标器件上无法有效实现此
类机制时，编译堆栈将替代软件堆栈。它会阻止可重入。

E
EEPROM

电可擦除的可编程只读存储器。一种可电擦除的特殊类型 PROM。一次写或擦除一个
数据字节。 EEPROM 即使在电源关闭时也能保留内容。

ELF

可执行链接格式。这种格式的目标文件包含机器码。调试和其他信息使用 DWARF 指
定。 ELF/DWARF 可提供优于 COFF 的优化代码调试。

Epilogue

编译器生成代码的一部分，负责释放堆栈空间、恢复寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。此代码在给定函数的任何用户代码之后、在函数
返回之前执行。

EPROM

可擦除的可编程只读存储器。通常通过紫外线照射来擦除的可编程只读存储器。

二进制 （Binary）
使用数字 0 和 1、以 2 为基数的计数体制。最右边的位表示 1 的倍数，右边第二位表
示 2 的倍数，右边第三位表示 4 （22）的倍数，以此类推。
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F
FNOP

强制空操作。强制 NOP周期是双周期指令的第二个周期。由于 PIC 单片机的架构是流
水线型，在执行当前指令的同时预取物理地址空间中的下一条指令。但是，如果当前
指令改变了程序计数器，那么这条预取的指令会被忽略，导致一个 NOP周期。

Free-Standing

一种实现，它接受任何不使用复杂类型的严格符合程序，而且在这种实现中，对库条
款 （ANSI ‘89 标准条款 7）中规定的特性的使用，仅限于标准头文件的内容：
<float.h>、 <iso646.h>、 <limits.h>、 <stdarg.h>、 <stdbool.h>、
<stddef.h>和 <stdint.h>。

访问入口点 （Access Entry Points）
访问入口点提供了一种方法，可将跨段控制传送到链接时可能未定义的函数。它们支
持独立链接引导应用程序段和安全应用程序段。

仿真 / 仿真器 （Emulation/Emulator）
请参见 ICE/ICD。

非扩展模式 （Non-Extended Mode）（PIC18 MCU）

在非扩展模式下，编译器不使用扩展指令和立即数变址寻址。

非实时 （Non Real Time）
指处理器执行到断点或正在单步执行指令或者 MPLAB IDE/MPLAB X IDE 正运行在软
件模拟器模式下。

非易失性存储器 （Non-Volatile Storage）
电源关闭时保留其内容的存储器件。

符号 （Symbol）
符号是描述组成程序的各个部分的通用机制。这些部分包括函数名、变量名、段名、
文件名和结构 / 枚举 / 联合标记名等。MPLAB IDE/MPLAB X IDE 中的符号主要指变量
名、函数名和汇编标号。链接后符号的值就是其在存储器中的值。

符号，绝对 （Symbol, Absolute）
表示一个立即数的值，例如通过汇编 .equ伪指令指定的定义。

G
GPR

通用寄存器。器件数据存储器 （RAM）的一部分，作为一般用途。

概要文件 （Profile）
对于 MPLAB SIM 软件模拟器，该文件是对寄存器执行的激励的摘要列表。

高级语言 （High Level Language）
编写程序的语言，它比汇编语言更不依赖于具体的处理器。

跟踪 （Trace）
记录程序执行的仿真器或软件模拟器功能。仿真器将程序执行记录到其跟踪缓冲区内，
并可上载到 MPLAB IDE/MPLAB X IDE 的跟踪窗口中。
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跟踪存储区 （Trace Memory）
跟踪存储区包含在仿真器内部。跟踪存储区有时称为跟踪缓冲区。

跟踪宏 （Trace Macro）
一个通过仿真器数据来提供跟踪信息的宏。由于该宏属于软件跟踪，所以必须将它添
加到代码中、必须重新编译或重新汇编代码，并且必须使用该代码对目标器件进行编
程，之后跟踪才会工作。

工具栏 （Tool Bar）
一行或一列图标，单击这些图标时将执行 MPLAB IDE/MPLAB X IDE 功能。

工作簿 （Workbook）
对于 MPLAB SIM 模拟器，是一种用于产生 SCL 激励的设置。

观察变量 （Watch Variable）
调试会话期间可在 Watches 窗口中监控的变量。

归档 / 归档器 （Archive/Archiver）
归档 / 库是可重定位目标模块的集合。由将多个源文件汇编为目标文件，然后使用归档
器 / 库管理器将目标文件组合为一个归档 / 库文件生成。可将归档 / 库与目标模块和其
他归档 / 库链接，生成可执行代码。

国际标准化组织 （International Organization for Standardization）
制订多行业和技术 （包括计算和通讯）方面的标准的一个组织。也称为 ISO。

过滤器 （Filter）
通过选择确定在跟踪显示或数据文件中包含 / 排除哪些数据。

H
Hex 代码 \Hex 文件 （Hex Code\Hex File）
Hex 代码是以十六进制格式代码存储的可执行指令。 Hex 代码包含在 hex 文件中。

宏 （Macro）
宏指令。宏指令是以缩写形式表示指令序列的指令。

宏伪指令 （Macro Directive）
控制宏定义体中执行和数据分配的伪指令。

环回测试板 （Loop-Back Test Board）
用于测试 MPLAB REAL ICE 在线仿真器的功能。

环境 （Environment）
MPLAB PM3——包含如何对器件编程的文件的文件夹。该文件夹可转移到 SD/MMC
卡。

汇编 / 汇编器 （Assembly/Assembler）
汇编是以符号形式描述二进制机器码的编程语言。汇编器是将汇编源代码翻译成机器
码的语言工具。
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ICE/ICD

在线仿真器 / 在线调试器：用于对目标器件进行调试和编程的硬件工具。仿真器具有比
调试器更多的功能，例如跟踪。

在线仿真 / 在线调试：使用在线仿真器或调试器进行仿真或调试的行为。

-ICE/-ICD：带有在线仿真或调试电路的器件 （MCU 或 DSC）。该器件总是安装在调
试头板上，并用于通过在线仿真器或调试器进行调试。

ICSP

在线串行编程。一种通过使用串行通信并使用最少数量的器件引脚对 Microchip 嵌入式
器件编程的方法。

IDE

集成开发环境，如 MPLAB IDE/MPLAB X IDE。
IEEE

电子电气工程师协会。

J
激励 （Stimulus）
软件模拟器的输入 （即为模拟对外部信号的响应而生成的数据）。通常数据采用文本
文件中一系列动作的形式。激励可以是异步的，同步的 （引脚），时钟激励或寄存器
激励。

机器码 （Machine Code）
处理器实际读和解释的计算机程序的表示。二进制机器码的程序由一系列机器指令
（可能还包含数据）组成。特定处理器的所有可能指令的集合称为 “指令集”。

机器语言 （Machine Language）
特定中央处理单元的指令集，不需翻译即可用于处理器。

基数 （Radix）
数字基，十六进制或十进制，用于指定一个地址。

交叉引用文件 （Cross Reference File）
引用符号表的一个文件及引用符号的文件列表。如果定义了符号，则在列出的第一个
文件中包含符号的定义。其他文件包含对符号的引用。

节点 （Node）
MPLAB IDE/MPLAB X IDE 项目组件。

静态 RAM 或 SRAM （Static RAM or SRAM）

静态随机访问存储器。目标板上可读 / 写且无需经常刷新的程序存储器。

警告 （Warning）
MPLAB IDE/MPLAB X IDE——提醒出现了可能导致器件、软件文件或设备物理损坏的
通知。

16 位汇编器 / 编译器——警告报告可能存在问题的条件，但并不暂停处理。在 MPLAB 
C30 中，警告消息报告源文件名和行号，但包含文本 “warning:”来将警告与错误
消息区分开。
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绝对变量 / 函数 （Absolute Variable/Function）
使用 OCG 编译器的 @ address语法放置在绝对地址的变量或函数。

绝对段 （Absolute Section）
具有链接器不能更改的固定 （绝对）地址的 GCC 编译器段。

局部标号 （Local Label）
用 LOCAL 伪指令在一个宏内部定义的局部标号。这些标号特定于宏实例化的一个给定
示例。也就是说，声明为 local 的符号和标号在遇到 ENDM 宏后不再可访问。

K
看门狗定时器 （Watchdog Timer， WDT）
PIC 单片机上在一段可选的时间长度后复位处理器的定时器。使用配置位来使能、禁
止和设置 WDT。
可执行代码 （Executable Code）
可装入来执行的软件。

可重定位 （Relocatable）
地址未分配到存储器中固定位置的对象。

可重定位段 （Relocatable Section）
16 位汇编器——地址非固定 （绝对）的段。链接器通过一个称为重定位的过程来为可
重定位段分配地址。

可重入函数 （Reentrant）
可以有多个同时运行的实例的函数。下面两种情况下可能发生函数重入：直接或间接
递归调用函数；或者在中断处理期间执行此函数。

控制伪指令 （Control Directive）
汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

库 / 库管理器 （Library/Librarian）
请参见归档 / 归档器。

快速操作存储区 （Access Memory）
仅 PIC18——PIC18 器件中的一些特殊寄存器，对这些寄存器的访问与存储区选择寄
存器 （Bank Select Register， BSR）的设置无关。

扩展单片机模式 （Extended Microcontroller Mode）
在扩展单片机模式下，既可使用片内程序存储器，也可使用外部存储器。如果程序存
储器地址大于 PIC18 器件的内部存储空间，执行自动切换到外部存储器。

扩展模式 （Extended Mode）（PIC18 MCU）

在扩展模式下，编译器将使用扩展指令 （即 ADDFSR、 ADDULNK、 CALLW、 MOVSF、
MOVSS、 PUSHL、 SUBFSR和 SUBULNK）以及立即数变址寻址。
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LVDS

低压差分信号传输。一种通过铜线进行高速 （每秒千兆位）数据传输的低噪声、低功
耗和低幅值方法。

对于标准 I/O 信号，数据存储取决于实际电压大小。电压大小可能受到传输线长度的
影响 （线路越长，电阻就越高，这会使电压下降）。但对于 LVDS，数据存储仅通过正
负电压值区分，而不是实际电压。因此，数据可以传输更长的线路距离，同时保持干
净、一致的数据流。

来源：http://www.webopedia.com/TERM/L/LVDS.html。
链接描述文件 （Linker Script File）
链接描述文件是链接器的命令文件。它们定义链接器选项并描述目标平台上的可用存
储器。

链接器 （Linker）
把目标文件和库文件组合起来生成可执行代码并解析一个模块对另外一个模块引用的
语言工具。

列表伪指令 （Listing Directive）
列表伪指令是控制汇编器列表文件格式的伪指令。它们允许指定标题、分页及其他列
表控制。

列表文件 （Listing File）
列表文件是列出为每条 C 源语句生成的机器码，源文件中遇到的汇编指令、汇编器伪
指令或宏的 ASCII 文本文件。

逻辑探头 （Logic Probes）
Microchip 的某些仿真器最多可连接 14 个逻辑探头。逻辑探头提供外部跟踪输入、触
发输出信号、 +5V 和公共接地端。

M
Makefile

包含用于 Make 项目的指令的文件。使用该文件可以在 MPLAB IDE/MPLAB X IDE 之
外使用 make make 项目。

Make 项目 （Make Project）
重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU

单片机。 microcontroller 的缩写形式。也写作 uC。

MPASM™ 汇编器 （MPASM™ Assembler）
Microchip Technology 用于 PIC 单片机、 KeeLoq® 器件及 Microchip 存储器件的可重
定位宏汇编器。

MPLAB ICD

Microchip 的在线调试器，与 MPLAB IDE/MPLAB X IDE 配合使用。请参见 ICE/ICD。

MPLAB IDE/MPLAB X IDE

Microchip 的集成开发环境。MPLAB IDE/MPLAB X IDE 附带有编辑器、项目管理器和
软件模拟器。
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MPLAB PM3

Microchip 的器件编程器。用于对 PIC18 单片机和 dsPIC 数字信号控制器进行编程。
可与 MPLAB IDE/MPLAB X IDE 配合使用或独立使用。代替 PRO MATE II。
MPLAB REAL ICE™ 在线仿真器 （MPLAB REAL ICE™ In-Circuit Emulator）
Microchip 的新一代在线仿真器，与 MPLAB IDE/MPLAB X IDE 配合使用。请参见
ICE/ICD。

MPLAB SIM

Microchip 的软件模拟器，与 MPLAB IDE/MPLAB X IDE 配合使用，支持 PIC MCU 和
dsPIC DSC 器件。

MPLIB™ 目标库管理器 （MPLIB™ Object Librarian）
Microchip 的库管理器，与 MPLAB IDE/MPLAB X IDE 配合使用。 MPLAB 库管理器是
用于将由 MPASM 汇编器 （mpasm 或 mpasmwin v2.0）或 MPLAB C18 C 编译器生
成的 COFF 目标模块组合成库文件的目标库管理器。

MPLINK™ 目标链接器 （MPLINK™ Object Linker）
MPLINK 链接器是 Microchip MPASM 汇编器和 Microchip C18 C 编译器的目标链接
器。 MPLINK 链接器还可以与 Microchip MPLIB 库管理器配合使用。 MPLINK 链接器
设计为在 MPLAB IDE/MPLAB X IDE 中使用，但是并不一定要在 MPLAB IDE/MPLAB 
X IDE 中使用。

MRU

最近使用的。指可从 MPLAB IDE/MPLAB X IDE 主下拉菜单中选择的文件和窗口。

命令行接口 （Command Line Interface）
程序及其用户之间的一种完全基于文本输入和输出的通信手段。

模板 （Template）
为以后插入自己的文件中使用而创建的文本行。MPLAB 编辑器将模板存储到模板文件
中。

模块 （Module）
执行预处理器伪指令后，源文件的预处理输出。也称为编译单元。

目标 （Target）
指用户硬件。

目标板 （Target Board）
构成目标应用的电路和可编程器件。

目标处理器 （Target Processor）
目标应用板上的单片机。

目标代码 / 目标文件 （Object Code/Object File）
目标代码是由汇编器或编译器生成的机器码。目标文件为包含机器码 （可能还有调试
信息）的文件。它可以直接执行，或为可重定位的，需要与其他目标文件 （如库文
件）链接，以生成完整的可执行程序。

目标文件伪指令 （Object File Directives）
仅当创建目标文件时使用的伪指令。

目标应用程序 （Target Application）
目标板上的软件。
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内部链接 （Internal Linkage）
如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

匿名结构 （Anonymous Structure）
16 位 C 编译器——未命名的结构。

PIC18 C 编译器——属于 C 联合成员的未命名结构。匿名结构的成员可以像外围联合
的成员一样进行访问。例如，在以下代码中， hi和 lo是联合 caster中的匿名结构
的成员。

union castaway {
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;

NOP

空操作。执行该指令时，除了程序计数器加 1 外没有任何其他影响。

O
OTP

一次性编程。非窗口封装的 EPROM 器件。由于 EPROM 需要紫外线照射来擦除其存
储内容，因此只有窗口式器件是可擦除的。

P
PC

个人计算机或程序计数器。

PC 主机 （PC Host）
任何运行支持的 Windows 操作系统的 PC。

PIC MCU

PIC 单片机 （MCU）指 Microchip 的所有单片机系列。

PICkit 2 和 3
Microchip 的器件开发编程器，通过 Debug Express 实现调试功能。要了解支持哪些器
件，请参见各工具的自述文件。

Pragma 伪指令 （Pragma）
对特定编译器有意义的伪指令。通常一条 pragma 伪指令用于向编译器传达实现定义
的信息。 MPLAB C30 使用属性来传达这种信息。

Psect

相当于 OCG 的 GCC 段，程序段的简称。被链接器视为整体的代码或数据块。

PWM 信号 （PWM Signal）
脉冲宽度调制信号。某些 PIC MCU 器件具有 PWM 外设。

跑表 （Stopwatch）
测量执行周期的计数器。
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配置位 （Configuration Bit）
可对其编程来设置 PIC MCU 或 dsPIC DSC 工作模式的专用位。配置位可或不可再编
程。

片外存储器 （Off-Chip Memory）
片外存储器指 PIC18 器件的一种存储器选择，这种情况下存储器可位于目标板上，或
所有程序存储器都由仿真器提供。从 Options>Development Mode （选项 > 开发模
式）访问 Memory 选项卡可打开 Off-Chip Memory selection （片外存储器选择）对话
框。

Q
器件编程器 （Device Programmer）
用于对电可编程半导体器件 （如单片机）进行编程的工具。

弃用功能 （Deprecated Feature）
由于历史原因仍然支持但最终将逐步淘汰且不再使用的功能。

嵌套深度 （Nesting Depth）
宏可以包含其他宏的最大层数。

清除 （Clean）
清除操作删除所有中间项目文件，例如活动项目的目标文件、 hex 文件和调试文件。
项目编译时会通过其他文件重新创建这些文件。

情形 （Scenario）
对于 MPLAB SIM 软件模拟器，是一种用于激励控制的特定设置。

R
RAM

随机访问存储器 （数据存储器）。可以任意顺序访问其中信息的存储器。

ROM

只读存储器 （程序存储器）。不能修改的存储器。

软件模拟器 （Simulator）
模拟器件操作的软件程序。

软件堆栈 （Stack, Software）
应用程序用来存储返回地址、函数参数和局部变量的存储区。该存储区由程序中的指
令在运行时动态分配。它支持可重入函数调用。

S
Shell

MPASM 汇编器 shell 是到宏汇编器的提示性输入接口。有两个 MPASM 汇编器 shell：
一个针对 DOS 版本，一个针对 Windows 版本。

Skew

不同时间出现在处理器总线上与指令执行有关的信息。例如，执行前一条指令的过程
中取指时，被执行的操作码出现在总线上；当实际执行该操作码时，源数据地址及其
值以及目标数据地址出现在总线上。跟踪缓冲区一次捕捉总线上的这些信息。因此，
跟踪缓冲区的一条记录将包含三条指令的执行信息。执行一条指令时，从一条信息到
另一条信息的捕捉周期数称为 skew。
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Skid

当使用硬件断点来暂停处理器时，在处理器暂停前可能再执行一条或多条额外的指令。
在预期断点之后执行的额外指令数称为 skid。
SQTP

请参见带序列号的快速批量编程。

三字母词 （Trigraphs）
由三个字符组成的序列，均以 ?? 开头，由 ISO C 定义用于替代单个字符。

闪存 （Flash）
按块 （而不是按字节）写或擦除数据的一种 EEPROM。

上电复位仿真 （Power-on-Reset Emulation）
在应用刚上电时，将随机值写到数据 RAM 区中来模拟 RAM 中未初始化值的软件随机
过程。

上载 （Upload）
上载功能将数据从一个工具 （如仿真器或编程器）传送到主机 PC，或将数据从目标
板传送到仿真器。

生产编程器 （Production Programmer）
生产编程器是一种编程工具，其中设计了可对器件进行快速编程的资源。它具有在各
种电压下进行编程的能力并完全符合编程规范。在生产环境中，应用电路需要在组装
线上传送，时间是极其重要的，所以尽可能快地对器件编程至关重要。

事件 （Event）
对可能包含地址、数据、次数计数、外部输入、周期类型 （如取指和读 / 写）及时间
标记的总线周期的描述。事件用于描述触发、断点和中断。

十六进制 （Hexadecimal）
使用数字 0-9 以及字母 A-F （或 a-f）、以 16 为基数的计数体制。字母 A-F 表示值为
10 至 15 （十进制）的十六进制数字。最右边的位表示 1 的倍数，右边第二位表示 16
的倍数，右边第三位表示 256 （162）的倍数，以此类推。

实时 （Real Time）
当在线仿真器或调试器从暂停状态释放时，处理器将在实时模式下运行并且完全像正
常芯片那样工作。在实时模式下，仿真器的实时跟踪缓冲区被使能并不断捕捉所有选
定的周期，同时允许所有中断逻辑。在在线仿真器或调试器中，处理器将实时执行，
直到有效断点导致暂停，或者直到用户暂停程序执行。

对于软件模拟器，实时仅意味着单片机指令的执行速度与主机 CPU 可模拟的指令速度
相同。

属性 （Attribute）
C 程序中变量或函数的 GCC 特性，用于描述特定于机器的性质。

属性，段 （Attribute, Section）
段的 GCC 特性，如 “可执行”、“只读”或 “数据”，它们可在汇编器 .section伪
指令中指定为标记。
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舒缓 （Relaxation）
将某一指令转换为功能相同但大小较小的指令的过程。这对于节省代码长度非常有用。
MPLAB ASM30 目前知道如何将 CALL 指令舒缓 （RELAX）为 RCALL 指令。当被调
用的符号处于当前指令的 +/- 32k 指令字范围内时，将会执行该操作。

数据存储器 （Data Memory）
在 Microchip MCU 和 DSC 器件中，数据存储器 （RAM）由通用寄存器 （General 
Purpose Register， GPR）和特殊功能寄存器（SFR）组成。某些器件还有 EEPROM
数据存储器。

数据监视和控制界面 （Data Monitor and Control Interface， DMCI）
数据监视和控制界面或 DMCI 是 MPLAB X IDE 中的一个工具。此接口提供对项目中应
用程序变量的动态输入控制。可使用 4 个动态分配的图形窗口中的任一个以图形形式
查看应用程序生成的数据。

数据伪指令 （Data Directive）
数据伪指令是指控制汇编器的程序或数据存储空间分配，并提供通过符号 （即有意义
的名称）引用数据项的方法的伪指令。

书签 （Bookmark）
使用书签可以轻松定位到文件中的特定行。

在 Editor （编辑器）工具栏中，选择 Toggle Bookmarks （切换书签）添加 / 删除书
签。单击该工具栏上的其他图标以移动到下一个书签或上一个书签。

数字信号处理 / 数字信号处理器 （Digital Signal Processing\Digital Signal 
Processor）
数字信号处理 （Digital signal processing， DSP）是对数字信号 （通常为已转换为数
字形式 （经过采样）的模拟信号 （声音或图像））的计算机处理。数字信号处理器是
设计为用于数字信号处理的微处理器。

数字信号控制器 （Digital Signal Controller）
数字信号控制器 （Digital Signal Controller， DSC）是具有数字信号处理能力的单片
机，即 Microchip 的 dsPIC DSC 器件。

顺序断点 （Sequenced Breakpoints）
按顺序发生的断点。断点的执行顺序为从下到上；即序列中的最后一个断点最先发生。

T
特殊功能寄存器 （Special Function Register， SFR）

数据存储器 （RAM）的一部分，专用于控制 I/O 处理器函数、 I/O 状态、定时器或其

他模式及外设的寄存器。

条件编译 （Conditional Compilation）

只有当预处理器伪指令指定的某个常量表达式为真时才编译程序段的操作。

条件汇编 （Conditional Assembly）
基于指定表达式在汇编时的值包含或忽略的汇编语言代码。

调试 / 调试器 （Debug/Debugger）
请参见 ICE/ICD。
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调试信息 （Debugging Information）
编译器和汇编器选项，在选中时，它们将提供不同程度的信息来用于调试应用程序代
码。关于选择调试选项的详细信息，请参见编译器或汇编器文档。

U
USB

通用串行总线。一种外部外设接口标准，用于通过电缆使用双向串行传输在计算机和
外部外设之间进行通信。USB 1.0/1.1 支持 12 Mbps 的数据传输速率。USB 2.0 支持最
高 480 Mbps 的数据传输速率，通常称为高速 USB。
W
Watches 窗口 （Watches Window）

Watches 窗口包含在每个断点更新的观察变量的列表。

外部标号 （External Label）
有外部链接的标号。

外部符号 （External Symbol）
具有外部链接的标识符符号。这可能是一个引用或一个定义。

外部符号解析 （External Symbol Resolution）
链接器搜集所有输入模块的外部符号定义来解析所有外部符号引用的过程。没有相应
定义的任何外部符号引用都会导致报告链接器错误。

外部链接 （External Linkage）
如果可以在定义函数或变量的模块外部对函数或变量进行引用，则函数或变量具有外
部链接。

外部 RAM （External RAM）

片外的读 / 写存储器。

外部输入线 （External Input Line）
用于根据外部信号设置事件的外部输入信号逻辑探针线 （TRIGIN）。

微处理器模式 （Microprocessor Mode）
PIC18 单片机的一种程序存储器配置。在微处理器模式下，不使用片内的程序存储器。
整个程序存储器映射到外部。

未初始化数据 （Uninitialized Data）
定义时未指定初始值的数据。在 C 中，

int myVar; 

定义了将驻留在未初始化数据段的一个变量。

未分配段 （Unassigned Section）
在链接器命令文件中尚未分配到特定目标存储器块的段。链接器必须找到用于分配未
分配段的目标存储器块。

尾数法 （Endianness）
多字节对象中的字节存储顺序。
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伪指令 （Directive）
源代码中控制语言工具操作的语句。

文件寄存器 （File Register）
片内数据存储器，包括通用寄存器 （GPR）和特殊功能寄存器 （SFR）。

X
系统窗口控件（System Window Control）
系统窗口控件位于窗口和某些对话框的左上角。单击该控件时通常会弹出包含
“Minimize”（最小化）、“Maximize”（最大化）和 “Close”（关闭）等项的菜单。

下载 （Download）
下载是指数据从主机发送到其他设备，如仿真器、编程器或目标板的过程。

限定符 （Qualifier）
次数计数器使用的地址或地址范围，或用作复杂触发中另一个操作之前的事件。

向量 （Vector）
复位或中断发生时应用程序跳转到的存储地址。

项目 （Project）
项目包含编译应用程序 （源代码和链接描述文件等）所需的文件以及这些文件与各种
编译工具和编译选项之间的关联。

响应延时 （Latency）
事件与其得到响应之间的延迟时间。

小尾数法 （Little Endian）
多字节数据的数据存储顺序机制，在这种机制中，低字节存储在较低的地址中。

消息 （Message）
显示出来的文本，警告在语言工具的操作中可能存在的问题。消息不会停止操作。

校准存储区 （Calibration Memory）
用来保存 PIC 单片机内置 RC 振荡器或其他器件外设的校准值的特殊功能寄存器。

序言 （Prologue）
编译器生成代码的一部分，负责分配堆栈空间、保留寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。该代码在给定函数的任何用户代码之前执行。

虚拟字节 （Phantom Byte）
dsPIC 架构中的未实现字节，在将 24 位指令字视为 32 位指令字时使用。虚拟字节出
现在 dsPIC hex 文件中。

修正 （Fixup）
链接器重新定位后将目标文件符号引用替换为绝对地址的过程。

Y
样机系统 （Prototype System）

指用户目标应用或目标板的一个术语。

异步 （Asynchronously）
不同时发生的多个事件。通常用来指可能在处理器执行过程中的任意时刻发生的中断。
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异步激励 （Asynchronous Stimulus）
为模拟被模拟器件的外部输入而生成的数据。

已初始化数据 （Initialized Data）
定义时已指定初始值的数据。在 C 中，

int myVar=5;

定义了将驻留在已初始化数据段中的一个变量。

已分配段 （Assigned Section）
在链接器命令文件中已分配到目标存储器块的 GCC 编译器段。

易失的 （Volatile）
阻止编译器应用会影响访问存储器中变量的方式的优化的变量限定符。

硬件堆栈 （Stack, Hardware）
调用函数时， PIC 单片机中存储返回地址的存储单元。

应用 （Application）
可由 PIC® 单片机控制的一组软 / 硬件。

源代码 （Source Code）
编程人员编写计算机程序所使用的形式。源代码以某种正规的编程语言编写，可翻译
成机器码或被解释程序执行。

源文件 （Source File）
包含源代码的 ASCII 文本文件。

原始数据 （Raw Data）
与一个段有关的代码或数据的二进制表示。

运行 （Run）
将仿真器从暂停状态释放，允许仿真器实时运行应用程序代码、实时改变 I/O 状态或
实时响应 I/O 的命令。

运算符 （Operator）
生成定义完好的表达式时使用的符号，如加法符号 “+”和减法符号 “-”。每个运算
符都有用于确定求值顺序的指定优先级。

运行时模型 （Run-time Model）
描述目标架构资源的使用。

运行时观察 （Runtime Watch）
Watches 窗口中的变量在应用程序运行时变化。要确定如何设置运行时观察，请参见
相应的工具文档。并非所有工具都支持运行时观察。

优先顺序 （Precedence）
定义表达式中求值顺序的规则。

Z
主机 （Pod）
在线仿真器或调试器的外壳。也叫做 “Puck”（如果外壳是圆的）和 “Probe”（不
要混淆为逻辑探头）。
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助记符 （Mnemonics）
可直接翻译为机器码的文本指令。也称为操作码。

暂停 （Halt）
停止程序执行。执行 Halt 与在断点处停止相同。

针对相应器件的 MPLAB 入门工具包 （MPLAB Starter Kit for Device）
Microchip 的入门工具包中包含研究指定器件所需的一切。查看正在运行的应用程序，
然后对所做的更改进行调试和编程。

针对相应器件的 MPLAB 语言工具 （MPLAB Language Tool for Device）
适合指定器件的 Microchip C 编译器、汇编器和链接器。根据应用要使用的器件选择语
言工具的类型，例如，如果要为 PIC18 MCU 创建 C 代码，请选择用于 PIC18 MCU 的
MPLAB C 编译器。

帧指针 （Frame Pointer）
引用堆栈中地址，并将基于堆栈的参数和基于堆栈的局部变量分隔开的指针。为访问
当前函数的局部变量和其他值提供了方便。

只读存储器 （Read Only Memory）
允许快速访问永久存储的数据，但不能增加或修改数据的存储器硬件。

指令 （Instruction）
告知中央处理单元执行特定操作，并可能包含操作中要使用数据的位序列。

指令集 （Instruction Set）
特定处理器理解的机器语言指令的集合。

致命错误 （Fatal Error）
引起编译立即停止的错误。不产生其他消息。

中断 （Interrupt）
传递到 CPU 的信号，它使 CPU 暂停执行正在运行的应用程序，把控制权转交给中断
服务程序（Interrupt Service Routine， ISR），以处理事件。完成 ISR 时，将恢复应用
程序的正常执行。

中断处理程序 （Interrupt Handler）
发生中断时处理特殊代码的子程序。

中断服务请求 （Interrupt Service Request， IRQ）

使处理器暂停正常的指令执行并开始执行中断处理程序的事件。某些处理器有几种中
断请求事件，允许具有不同优先级的中断。

中断服务程序 （Interrupt Service Routine， ISR）

语言工具——处理中断的函数。

MPLAB IDE/MPLAB X IDE——当产生中断时进入的用户生成代码。代码在程序存储器
中的位置通常取决于所产生中断的类型。

中断向量 （Interrupt Vector）
中断服务程序或中断处理程序的地址。
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中央处理单元 （Central Processing Unit）
器件的一部分，负责取出要执行的正确指令，对指令进行译码，然后执行指令。需要
时，它和算术逻辑单元 （Arithmetic Logic Unit， ALU）配合工作，来完成指令的执
行。中央处理单元控制程序存储器地址总线、数据存储器地址总线以及堆栈的访问。

状态栏 （Status Bar）
状态栏位于 MPLAB IDE/MPLAB X IDE 窗口的底部，指示光标位置、开发模式和器
件，以及有效工具条等当前信息。

字母数字字符 （Alphanumeric）
字母数字字符由字母字符和十进制数 （0,1, …, 9）组成。

字母字符 （Alphabetic Character）
字母字符指属于拉丁字母表 （a, b, …, z, A, B, …, Z）中字母的字符。

左值 （L-value）
引用可被检查和 / 或修改的对象的表达式。左值表达式用在赋值的左侧。
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